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Our colours look better 
than ever, and the blacks 

go like the wind* 

When it comes to all-round 

office printing, Canon’s new, 

improved BJC-4100 is head 

and shoulders above the 

competition. 

For starters, it produces 

outstanding colour quality with 

a resolution of 720 x 360 dpi, 

twice that of its predecessor. 

This means it gives you 

twice the definition, smoother 

gradations and better half¬ 

tones. And it does so at 

virtually the same speed. 

Then it takes this one 

step further. 

Using four colour process 

printing, the BJC-4100 can 

produce more than 16 million 

colours. And with its advanced 

driver, it gives you something 

no other direct competitor 

can. The best resolution, in 

best mode on plain paper. 

Twice the colour resolution. 
720 x 360 dpi full colour, 
optimised for plain paper. 

Fastest black & white. 
Up to 4 pages per minute, fastest 
on the Bubble JetVink jet market. 

But colour printing is only 

half the reason why it’s a cut 

above the rest. 

For black and white output, 

the BJC-4100 has a black ink 

Canon 
BUBBLE JET PRINTERS 

Canon Australia Pty Ltd ACN 005 002 951 Canon, the Canon logo, BJC and Bubble Jet are registered trade 

cartridge with at least double 

the print nozzles of any direct 

competitor. Combined with a 

high-speed engine and bi¬ 

directional printing capabilities, 

the result is an unsurpassed 

speed of up to 4 pages per 

minute. 

And the quality is equally 

/ impressive. 

The BJC-4100 gives you a 

black and white resolution of 

360 dpi, with 720 x 360 dpi 

smoothing for extra sharp edges 

on text. 

Then for half-tone images, 

it can actually reproduce up to 

256 levels of grey for extremely 

accurate results. 

Canon’s new BJC-4100. It 

really does stand out as the 

ideal all-round office printer. 

For more information, give 

Canon a call on 1 800 021 167. 

iks of Canon Inc. MSV&P/CS 1287 



YOU 
KNOW 
WHAT YOU 

WANT 
BUY DIRECT 
FROM DELL AND 

SAVE 
pentium 

166MHz Intel Pentium*Processor 
8Mb EDO RAM (upgradeable 128 Mb) 
1Gb EIDE Hard Disk 
15" Trinitron Monitor 
CD-ROM, Speakers and Sound 
Fax modem 28.8 BPS 
Keyboard/Mouse 
Windows* 95 

OPTIPLEX 133MHz 
INTEL PENTIUM® PROCESSOR 

133MHz Intel Pentium*Processor 
8Mb EDO RAM (upgradeable 128 Mb) 
1Gb EIDE Hard Disk 
15” Trinitron Monitor 
CD-ROM, Speakers and Sound 
Fax modem 28.8 BPS 
Keyboard/Mouse 
Windows* 95 

3 YEAR WARRANTY 
LIFETIME TELEPHONE 

SUPPORT 

30 DAY MONEY BACK 

GUARANTEE 

D6U 
1800 812 391 
THE VERY PERSONAL 
COMPUTER COMPANY 
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Always keep a copy of Communique handy if 

you're venturing into dangerous realms. Com¬ 

munique can be a great source of comfort in 

all kinds of extremities. 

Doug Rowell is deriving such consolation 

as he perches on what remains of a light air¬ 

craft, below Alt Tavuvur, one of the smoulder¬ 

ing volcanoes that wreaked devastation on 

the airport at Rabaul in New Guinea. 

Doug wins a refreshingly cool Commu¬ 

nique T-shirt to change into after cleaning up 

the rubble that was once his house. 

You too can be the proud owner of a simi¬ 

larly glamorous garment, by sending us a 

snap of yourself with a copy of Communique. 

Address your entry to the “Here’s me and 

Communique in..." Competition, RO. Box 

222, St Leonards, NSW 206S. You’ll need to 

include your name, address, phone number 

and Communique membership 

number to be eligible. 

Love 
happy! 

The Communique team meets a wide range of 

people in the daily course of affairs. Many of them 

are obsessed with software, not least the four folk 

who feature in this month’s cover story. 

Love, dear reader, may be too soft a word to 

describe the joy each of these individual Microsoft 

software users feels for their applications. Passion, 

yes! Naked, unbridled emotion...well, maybe that’s 

going a little far. 

In the hubbub of activity over recent months 

concerning that tine suite of software applications, 

Office 96, we’ve often forgotten the humble single¬ 

application user. And yes, there are still many of 

them out there. In this issue we redress that bal¬ 

ance and focus on those who tinker away day after 

day with a single application to help them do their 

job better. 

Within the Communique bunker, we’re pretty 

much like those we’ve written about this month. We 

slavishly use Microsoft Word for Windows 95 and 

few other applications (apart from, increasingly, 

our trusty Internet Explorer to surf the Net). 

When you use an application day after day it 

becomes a bit like an old sock. Comfortable, a little 

smelly, but an important and inseparable part of 

your life. If you have any old socks or new stories 

you’d like to share about your own love affair with 

a Microsoft application, please feel free to drop us a 

line and share your experience. 

Meanwhile, epjoy this splendiferous issue. 

Darren Edwards 

In case you were wondering about our icons: 

■| This icon signifies a special offer or competition 
H for Communique members only... 

Windows 95 Windows 

MS-DOS Macintosh 

OA fax service for Communique members to 
access more information from Microsoft 



YOUR SAY 

1996 

INSIDE INFO 

Dazzlers from this month’s treasure trove include a 

new adventure for the Magic School Bus crew, an 

even better Bookshelf and the Internet Explorer 

now for Windows 3.1 and Macintosh. 

w 
ASK THE WIZ 

Where would we be without wizardry? As if by 

magic, quandaries and queries, questions and 

quizzes are here transformed perfectly and forever. 

HOT TIPS 

So many members have been burning to let us 

know their hints and tips that they’ve got piping 

hot - and here they are, cooked to perfection. 

UPGRADES 

Don’t bother with searching out basements and 

lofts for one-off sales. Right here there are trestles 

of treasure neatly laid out to be selected at leisure. 

5T 

m 
Readers armed with magnify¬ 

ing glasses and microscopes 

are to be treasured. Close 

examination of font serifs, vol¬ 

ume numbers and word jum¬ 

bles will one day reap 

rewards. Sleuths and Sher- 

locks, keep up the good work! 

TECH ROAD 
MAP 

Our invitation in 

February evoked 

these prize-winning 

suggestions from 

expert members 

about the hottest 

technical sites on 

the Internet and 

MSN. 

UU 
OH, YOU BEAUTIFUL ARP! 

All kinds of users are finding themselves becoming 

very fond indeed of their 

favourite pet programs. Here j 

we meet a selection from the I 

age-old profession of match¬ 

making to the very contem¬ 

porary pursuit of user inter¬ 

face design, and from the 

age-old activ- 

DIRECTORY 

From one end of the continent to the other, we’ve 

collected a dazzling roll-call of helpers to dispel all 

anxieties, once and for all. 



TUTORIAL - 

CREATING DATABASES 

COMING DOWN THE LINE 

Simply download the latest updates to your latest 

upgrades and you won’t miss a shot or a beat or for 

that matter a fact, as well as enjoying the best that 

those favourite Home products - Cinemania, Music 

Central and Encarta - have to offer. 

littl 

Here’s help on experiencing some of the new fea¬ 

tures of Access 

KIDS’ COMMUNIQUE- 

OUTER SPACED OUT 

Space is the place, just the place, 

for travel and battle, 

for fun and a race. 

Two fine places to 

find out more about 

the many faces of 

space are cyberspace 

(a fancy name for the 

Internet), and of 

course, the Magic School 

Bus. And we meet an astronomer 

to help us even more. 

m 
COMMUNIQATE - 

SHIRLEY PURVIS 

The popular comedienne 

recounts, true to her 

Internet alias, cranking 

up the gardening com¬ 

puter in the old toolshed 

only to have to switch 

for most of her more 

urgent tasks. 

liu 
OFFER OF THE MONTH 

A fully digital 

camera will 

liven up all 

your comput¬ 

ing efforts, 

both business 

and personal, 

with snapshots 

and video you 

can include on 

your own per¬ 

sonal computer 

or laptop. 

m 
BACKPAGE 

Competition comer calls on Jack 

Sprat, Simple Simon and Old 

King Cole to get computing 

(and to try a crossword). 



Greg Waterhouse... looking for salad ingredients for his free lunch 

Dear Communique, 

This morning I received a parcel in the post - it was unexpected 

so I opened it with anticipation. Inside, I found a copy of 

Microsoft Golf and a letter from Microsoft Communique. I was 

amazed. Why would Communique send me a copy of Microsoft 

Golf? Then I read the letter. It informed me that when I renewed 

my membership in November 95 there was an offer for a per¬ 

sonal organiser. Apparently you ran out of stock so sent me MS- 

Golf instead. I was overjoyed! I quickly checked the retail price 

of MS-Golf. What amazed me even more was that it was selling 

for $79! I only paid $49 for my membership. That meant that I 

paid $49 for what would normally cost me $128! I was flabber¬ 

gasted. Maybe it’s a plot to get me back on side after I was so 

disappointed with Wmdows 95.1 immediately opened the Golf 

pack and found that if I registered within 7 days I could get a 

FREE screen saver or mouse mat. Is there no end to the prover¬ 

bial “free lunch”? 
Greg Waterhouse, 

Woodford, NSW. 

This letter wins a copy of Microsoft’s Music Central 96 for 

Windows 95. 

Partition Petition 
Dear Communique, 

I waited eighteen months for Windows 95 to appear before buying a 

new computer, so that the hardware would be more up to date for 

it I’m so glad I waited - Windows 95 runs fabulously for me (in the 

literal sense of that word). I got Plus! as well, and admire the way 

parts of the maintenance programme now run automatically. And 

the Wmdows 95 interface and behaviour are so slick, and 

smoooooooth. 

Before now, I’d thought the PC had got as far as motor cars in 

their early days, when you needed a fully qualified mechanic to go 

with you eveiywhere, because you usually had to tear your' car 

apart and reassemble it several times during a day’s outing. Now the 

PC is getting closer to the kind of reliability Messrs Rolls, Royce, 

and Ford introduced, where virtually all you need do is jump in and 

drive. 

I had a 1.25Gb hard disk included in my new computer, parti¬ 

tioned into one 500Mb and four 175Mb logical drives -1 wanted to 

keep the big partition clear for very big graphics-rich files, 

you see. So my Wmdows 95 went into one of those 175Mb 

drive, because I’d figured out that there’d be plenty of space 

to spare for it there, despite its reputed bloat. Ah, little did 

I know! 

And so next I started installing all my old software, 

including a great number of upgrades to 32-bit heaven - all 

into the other drives but none into that Wmdows 95 drive. 

Of course, I knew that most software these days adds its 

few files to the Windows directoiy, and adds various small 

applets to the msapps sub-directory of the Windows directo¬ 

ry. But 175Mb sounded vast enough for all of that. 

That was until I shoved in the CD-ROM disk to install 

Office Professional for Wmdows 95 and then started its 

setup ball rolling.. .only to be greeted by the dismaying 

message that there wasn’t enough room on my Wmdows 95 

drive for it to install - not enough room on a 175Mb drive! 

Yes, I’m always very careful to read on the outside of 

software boxes precisely how much hard disk space and 

memory are required. But this information is no longer 

adequate as many people partition their hard disks to save 

wasted space and to organise more convenient filing 

systems. 

I believe this information should divide up the hard disk 

space requirement into two parts - one saying how much 

space you need on your Windows partition, and the other 

how much you need elsewhere. If all my software boxes 

and manuals had included that information, I wouldn’t have 

fallen into such a time-consuming trap, but would have 

allowed vastly more space for Wmdows 95 itself. 

How about it, Microsoft? 

Oh, by the way, I have a number of friends who are 

always taking shots at Microsoft Yet in the last few months 

when I’ve been waiting for great numbers of application 

upgrades to be delivered, all the ones from Microsoft have 

arrived with startling rapidity, while all the non-Microsoft 

ones have taken far longer - I’ve been waiting for some for 

over eight weeks, now. 
Ray Sinclair-Wood, 

Quorn, SA. 

Mysteries do never cease 
Dear Communique, 

This is of no consequence but interesting to the logical 

mind. In 1994 you issued two Communiques called volume 

54, namely November and December, but no volume 53. In 

1995 you issued two Communiques called volume 62, 

namely October and November, but no volume 63. Why? Or 

is this another of “Life’s Little Mysteries”? 
Bill Caukill, 

Balmain, NSW. 
Editor replies: 

Bill, we’re as stumped as you are. 



Missing mail found! 
Dear Communique, 

In your reply to Stephen Schmideg’s letter (March 1996), you 

say problems with the Communique renewal process have now 

been identified and solved. Sony, that’s not totally true. In spite 

of several letters and phone calls to-ing and fro-ing between us I 

feel there is still a glitch. I believe I have paid for my member¬ 

ship twice and had it renewed for only eight months. But it’s all 

too complicated for anyone to decide what’s gone where. Oh 

well... such is life. 

I must say, when I contacted your magazine, I did receive 

the missed magazine when I first brought it to your attention - 

very promptly and with a friendly smile. 

So I’m still enjoying your magazine and tips and that’s why I 

will renew when the time comes. 
Malcolm Mason, 
West Perth, WA. 

What a splendiferous font! 
Dear Communique, 

I have a query that has been the subject of much discussion 

around here for several months now. It’s nothing overly techo or 

anything, I just need you to identify a font for me. 

Each month in Communique (a damn fine magazine by the 

way) there’s a font used which is unlike any other font I’ve ever 

found. It almost looks like hand drawn letters, with lots of 

squiggles coming off it It’s really very cute. And there’s another 

that looks like a scratchy painted font. 

In the March 1996 issue they are both on pages four and five 

of Kid’s Communique. One is used in the title “Sea Creatures!”, 

and the other font is used in the title “Wild And Wacky Destina¬ 

tions!” 

If you could let me know what these two fonts are (and 

where I could get them) I’d be very grateful. 
Des Embrey, 

Brisbane, Qld. 
Editor replies: 

Glad to see you like some of the wackier fonts. The ones you 

are interested in are'Remedy’ and ‘WheresMarty’. Just call 

your local computer reseller and ask for them. 

We welcome letters from Communique members on all subjects regarding 
Microsoft and Communique. 

The most interesting letter each month will win a 
Microsoft software product. 

Send to: YOUR SAY, Communique Magazine, 
P.O. Box 222, St Leonards, NSW 2065. 
Email: cmq_ed@msn.com 

Communique regrets we are unable to enter into individual correspon¬ 
dence; we reserve the right to edit letters for reasons of space; and the 
views expressed in these pages do not necessarily represent those of 
Communique magazine or Microsoft Pty Ltd. 

Discrimination or what? 
Dear Communique, 

I refer to the March 1996 issue of Communique and the Great 

Communique Qantas Techo Treasure Hunt. I find this competi¬ 

tion to be a blatant act of discrimination on your part as it is only 

open to those persons lucky enough to have access to the Inter¬ 

net or Microsoft Network. 

What about the thousands of your other readers who are 

not fortunate enough to have this facility? Are they being forgot¬ 

ten once again? 

Of recent times the Communique magazine, in the main, 

has only catered for those with Windows 96 and access to the 

Internet. There are many, many readers out there in the real 

world who do not have Wmdows 95 or Internet access, so how 

about catering for them once in a while? 
Kevin Buckland, 

Perth, WA. 

Editor replies: 

In addition to the Communique Qantas Techo Treasure Hunt 

we run many, many competitions each year which do not 

require a connection to the online world. In fact, as this is 

only the second competition that has required Communique 

readers to go online to find answers (the first being in the 

Tech Road Map in the previous issue), I can’t really see haw 

we’re discriminating against non-Internet users. We also con¬ 

tinually publish the majority of our hints and tips and arti¬ 

cles on a wide range of software, from Windows 95 to Win¬ 

dows 3.11 and Macintosh. 

More manual madness! 
Dear Communique, 

I agree wholeheartedly with “Manual Madness” Ron Bradford in 

your March issue. Wrong page references in Microsoft manuals 

are nothing new. To my recollection this has been something we 

have had to put up with ever since Microsoft began writing 

manuals. It really is very infuriating to turn to a page reference 

and find no resemblance to the subject matter. I would have 

thought by now they could have improved things. Perhaps a 

software package could be written which checks that refer¬ 

ences to pages are correct 
Richard Lyon, 

West Leederville, WA. 
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Competition Bug? 
Dear Communique, 

I look forward to your magazine arriving in our mail box every 

month. You do a wonderful job of collecting articles for this 

magazine and obviously a lot of time, effort and love goes into 

the making of it. When it has arrived I have to wait for a few 

days before reading it because it is not my mail to read and 

I have to wait for permission. The thing is, I am not a member of 

Communique. The reason for this is that money doesn’t grow on 

trees and $49 for membership is a bit out of my league. Fortu¬ 

nately, I still get to er\joy your magazine, even if I cannot enter 

your competitions or order any software. 

I recently opened your February 1996 magazine to a word 

puzzle in the Kids’ Communique section which was a competi¬ 

tion to win a SideWinder 3D Pro Joystick. I instantly went about 

finding the words listed and translated the hidden message as 

“Remember you can always send the Little Wiz all your ques¬ 

tions. He is ready and willing to help you with his answers. 

Gruesome Grace Frankenstein Wolf Man Zarka Alien”. 

Fortunately, before thinking I had made a mistake early in 

the message, I went back through and found a second “Tad”, 

a word in the puzzle that had a twin and obviously neglected 

brother (perhaps overlooked or thrown in for some fun)! 

I thought I would let you know that this second “Thd” exist¬ 

ed and no doubt some very excited Communique kid will enter 

the competition with a note about a second “Tad”. 

It’s not only kids who look at the Kids’ Communique. 

Keep up the good work. 
Jacqueline Murfet, 

Riverside, Tas. 

Editor replies: 

The ‘find a word” competition has proven so popular with 

Communique Kids (and some Communique adults, too!), 

that we’ve printed another in this issue, which you’ll find on 

page 28. By the way, yes there was an additional “Tad" in the 

‘find a word”. Intentional or not? We’ll let you be the judge. 

Re-re-re-re-gistering 
Dear Communique, 

I have bought quite a lot of MS software and have been a Com¬ 

munique member for over a year. Every time I purchase MS 

software I open the box and the registration card drops out and 

asks the same old questions over and over again. Microsoft 

must have my details at least 10 times. I suggest you have a box 

on the registration card that asks for your Communique number 

or a registered user’s number and let your computer fill in the 

details rather than have purchasers waste their time filling in 

the same old boring questions each time they purchase some 

software. Perhaps people might be more inclined to send in 

their cards if this was the case. 

§ 
o 

Waste watching 
Dear Communique, 

I write this letter in frustration and in the hope that I may save a 

few trees. I recently accepted the special offer to renew my sub¬ 

scription to Communique. Being a Macintosh user I looked to 

see if I needed to indicate this to accept my “Special Offer” but 

there was no indicator. No need to worry I thought, Microsoft 

has a good database product. I will be on their records, so I for¬ 

warded my response. Some time later I had my first indication 

that all was not well. I received two copies of the January edi¬ 

tion of Communique, but no special offer. This was to follow 

later - a copy of Encarta 95 for Windows, oh so Mac friendly! 

But more was to follow. I registered some new Microsoft 

software about three months ago. My reward for this was a 

copy of your Christmas magazine - in February, having already 

received one in December. 

I can only assume from this that you don’t use your own 

products, or surely you would have avoided all this waste. 
Mark Skerritt, 

Middle Park, Vic. 

Don’t believe everything 

you read 
Dear Communique, 

I joined up at the end of January full of expectation only to start 

reading articles on how people had trouble getting their sub¬ 

scriptions through. Being new to computing this caused a mas¬ 

sive dive in my levels of expectation hearing all these people 

whingeing - especially in your own magazine (some kind soul 

sent me a back issue). I did receive a receipt for my subscrip¬ 

tion so my hopes rose a little, but I didn’t receive an issue in 

February! 

Living 300kms from Perth I don’t get to the big smoke very 

often, but a forced visit in March saw me wide-eyed with won¬ 

der at all the goodies those city folk enjoy. It will come as no 

surprise to you that within hours of arriving in the city I was the 

proud owner of a brand new Microsoft Office Value Pack! 

I drove home full of a new (if different) expectation. On my 

arrival home I experienced more joy when I found the March 

issue of Communique. But I also experienced a dilemma Which 

to look at first? The magazine or the software? 

I chose Communique. Can you imagine the sinking feeling 

of being cheated when I read of your wonderful offer to Com¬ 

munique members of $50 off my lovely new Value Pack - plus 

the extra goodies you offered for the first 1000 orders? 

So, I wish to thank everyone involved in writing in with their 

moans and groans. That negative input meant I lost an opportu¬ 

nity of saving $50! I will not listen to them any more. 
Ron Walker, 

Manjimup, WA. 

Dean Gobell, 



Windows 95 free Internet 

offer from On Australia 

Hello!_ 
Welcome to Inside Info, the section where 

you’ll find all the news on new products from 

Microsoft as well as bits and pieces on what’s 

happening inside Microsoft itself. 

The ultimate in reference 

Microsoft 

Bookshelf 1996-97 

Quick, easy and comprehen¬ 

sive, the latest version of 

Bookshelf combines nine 

completely updated refer¬ 

ence works, a brand-spank¬ 

ing new interface and two 

great new books. 

Microsoft Bookshelf 1996-97 is a whopper, with 

5000 Internet sites just a click away. Monthly Book¬ 

shelf updates are also available via the Microsoft 

Bookshelf Internet Directory 96, as well as all the 

most up-to-date info on the world from the Microsoft 

Encarta 96 Concise World Atlas. 

Microsoft Bookshelf 1996-97 includes updated 

versions of the American Heritage Dictionary, The 

Original Roget’s Thesaurus, The World Almanac and 

Book of Dictionary Quotations, and The People’s 

Chronology. You can even take a look at the Year in 

Review which highlights the words, information and 

news of last year. 

You can access this reference from within any 

program for Windows or Macintosh, just by taking 

the QuickShelf Shortcut, making it even easier to 

explore the 2500 images, five hours of sounds, 50 

maps and 100 video and animation clips in this title. 

Microsoft Bookshelf1996-97 is available 

late May with an ERP of $79. 

HotFax code: 1226. 

Over half a million people have already upgraded to Microsoft 

Windows 95. And if you join them, by purchasing this great new 

software, you’ll also get up to 20 hours free access to the Internet 

from On Australia* - worth around $ 100. Communique members 

who buy Windows 95 direct from Microsoft will also receive a free 

copy of Microsoft Plus! worth $69. 

If you’re a Communique member already enjoying the benefits of 

Windows 95, you’ll still he able to get the 20 hours free access to the 

Internet Just purchase Microsoft Plus! direct from Microsoft and 

you’ll qualify for the free offer. 

So, why not discover the advantages of Windows 95? You’ll be 

amazed at how fast and easy it makes working with your computer. 

For more information call Microsoft Sales Information Centre on 

(02) 870 2111 or, if you’re outside the Sydney area, I 800 257 253. 

* 20 hours must be used within a one month period. Offer only available with 
purchases of fully packaged product or upgrades bought from Microsoft between 12th 
April and 30th June 1996. Conditions apply. You must register for the offer before 31 st 
December 1996. Offer available toll-free in all capital cities except Darwin. Outside 
these cities, users will incur STD telephone charges to access the On Australia server. 

A geographic adventure 

The Magic School Bus 

Explores 

Inside the Earth 

Get your kids into the spirit 

of adventure with the Magic 

School Bus. This much- 

acclaimed CD-ROM series 

has another title full of sci¬ 

ence fun. 

The Magic School Bus Explores Inside the Earth 

will transport kids into the fabulous animated world 

of Ms Frizzle and her class, and lead them through 

the fascinating facts about our planet and geology. 

From a dark cavern to a rumbling volcano, the 

hunt is on for rocks missing from classmate Arnold’s 

rock collection. It’s up to the kids to explore six exot¬ 

ic places and take part in interactive science experi¬ 

ments to locate the missing items. 

Overall, the Magic School Bus uses great graph¬ 

ics, video clips and sounds to keep kids entertained 

as they learn and take part in activities. 

The Magic School Bus Explores Inside 

the Earth is available late May with an 

ERP of $69. HotFax code: 1231. 
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Two new master mind 

Mastering Series 

Access and Visual C++ 

Microsoft’s educational 

material for professionals, 

the Microsoft Mastering 

Series, is boasting two 

more additions that 

will have developers 

geared up and ready 

to take on the latest 

technologies. 

Mastering Visual 

C++ will enhance 

developers’ expertise 

in programming and 

teach them how to 

build ActiveX controls 

and containers, while 

Mastering Microsoft Access updates developers on 

the Visual Basic programming system (applications 

edition) and the ActiveX Technologies programming 

model. 

The Mastering Series has successfully helped 

developers maintain skills that keep them competitive, 

and able to build the latest applications with the latest 

smart and economical option for staff training. 

Mastering Microsoft Access Programming and 

Mastering Microsoft Visual C++ are available 

now with an ERP of $159 each. 

Oops! 
We put the wrong picture in last month’s article on the 

Microsoft Office Value Pack (page 17, April issue). 

Instead of a pic of a snazzy Windows 95 Starts Here 

CD-ROM one of the Windows 95 Training books pack¬ 

age snuck in instead. Our apologies for any confusion. 

News from the Net! 
Australian spot 
Microsoft Australia now has its own space on the Internet 

within the Microsoft Web site. So for information specifically 

for Australian users, keep your eyes peeled here: 
http://www.microsoft.com/australia 

Hard core Web 
Frontpage is a great new client/server Web publishing tool 

that even non-programmers can use to develop professional 

sites. Designed for a multi-user environment, Frontpage 

allows each development task to be performed on the best 

suited platform, so whether you are developing your content 

locally, across a LAN, or over the Internet, you’ll have all the 

required flexibility. Frontpage also allows you to copy Web 

sites between platforms and servers while keeping all pro¬ 

gramming intact. 

The client software includes Frontpage Explorer (for creat¬ 

ing, viewing and maintaining Web sites), FrontPage Editor (for 

creating and testing Web pages), To Do List (for tracking user 

tasks), WebBots (drop-in functions that save programming 

time), and a bunch of Wizards and templates to boot 

The server software includes Personal Web Server (which 

supports HTTP and CGI standards), Server Extensions (which 

enables servers to work with Frontpage) and Server Adminis¬ 

trator (for managing security and access to your server). 

For more information go to: 
http: //www. microsoft. com./MSOffice/FrontPage 

More Internet exploring 
At last, Microsoft’s popular Internet browser for Wmdows 95 

is now available for Wmdows 3.11 and Macintosh. Internet 

Explorer is easy to use, supports a bunch of multimedia 

extensions - and it’s free! You can download it from: 
http://www.microsoft.com/ie 

Last chance for Tech*Ed 96! 
At Microsoft Tech'Ed 96 you can 

expect more than just the most impor¬ 

tant technical conference of 1996. Not 

only are there over 70 presentations 

on topics including the Internet and 

Intranets, Networking, Enterprise 

Computing, Messaging, OLE, Office 

Development, VBA, ActiveX and Data 

Management, but you get a chance to participate in a host of extra 

special interest activities to ensure that this will be one conference you 

will remember. It’s three and a half days packed with the most up-to- 

date information, so register now to avoid disappointment For more 

details, call the Tech*Ed hotline on (02) 236 9387, or check out 

“http://www.microsoft.com/showcase” for the latest breaking news. 



INSIDE 

Special licence discount 
Now the Microsoft Open Licence Program (MOLP) makes man¬ 

aging your Microsoft Windows 95 and Microsoft Office for Win¬ 

dows 95 software even easier (on your pocket!). 

The Open Licence is the easiest way to get legal and stay that 

way. If you have 13 PCs or more in your office you can purchase 

your software via Open licence and know exactly where you 

stand, with better pricing, flexibility and easy administration. 

Open Licence users stay current too, because they receive all the 

upgrades for the next two years. 

Until June 30 you can take advantage of special pricing deals 

on Office and Windows products, with Office costing just $260. 

And if you’ve been thinking of changing to Microsoft Office or 

upgrading, this is a great time because there’s even better pricing 

for you. 

Check with your local Microsoft software reseller to find out 

more about the Microsoft Open Licence Program (MOLP). 

February Crossword solution 
The February Cross¬ 

word - labelled as no. 10 

but really no.9 (just to 

be extra cryptic) - was 

well negotiated by 

Ms S. Bertolini of 

Dianella, WA. She will 

soon be the happy 

owner of a copy of 

Microsoft’s Cinemania 

96 for Windows 95. 

March Crossword solution 
Our March Crossword - described (truthfully) as no. 10 - 

efficiently knocked over 

by Karen Palmer of 

Ipswich, Qld., who will 

soon be the proud pos¬ 

sessor of a copy of 

Microsoft’s Cinemania 

96 for Windows 95. For 

a chance to emerge vic¬ 

torious in similar (and 

some rather different) 

challenges, turn now to 

page 56 of this issue. 

Two ways to be an 
appmeister! 
There’s more than one way to skin a cat, and there’s more 

than one way to learn an app! Especially if you check out two 

of the best-selling series of books from Microsoft Press, the 

Running series, and the Step by Step series! 

If you want to get to know the workings of your favourite 

application inside out, pick a Running title - these books give 

you a guided tour through all the aspects of the software 

you’re using. 

If you’re ultra busy, and you want to learn in quick stages, 

the Step by Step books are a no-fuss short cut to expertise. 

These are just a few of the titles that are available (Here 

kitty kitty...). 

Running Microsoft Excel for Windows 95 

This is a comprehensive user’s guide 

and reference for features, functions, 

and commands. Using real-world 

examples, screen illustrations, and 

detailed reference information, Run¬ 

ning Microsoft Excel for Windows 95 

covers a wide range of topics. 

You’ll learn about cell and range 

manipulation using the mouse, using 

Visual Basic for Applications, creating 

charts and graphs and using the Pivot¬ 

Table Wizard. There’s also a pile of Shortcuts, tricks, timesav¬ 

ing tips, and troubleshooting information included. 
Running Microsoft Excel for Windows 95 is available now, 
withanERP of $59.95. ISBN 1-55615-831-9. 

Microsoft Access for Windows 95 Step by Step 

Microsoft Access for Windows 95 Step 

by Step will take beginners and inter¬ 

mediate users through 16 speedy 

lessons to become database whizzes. 

And with this further addition to the 

range, building 32-bit databases will be 

a snap. 

From understanding the data 

basics to customising reports and 

forms, the exercises and practice files 

in this book are designed with a busi¬ 

ness focus, to give readers a hands-on approach to learning 

about Access. 
Microsoft Access for Windows 95 Step by Step is available now, 
with an ERP of $59.95. ISBN I-55615-876-9. 



Td like to nominate Carl and Gary’s Visual 

Basic Home Page,” writes Brian Cameron 

who, as you read this, is basking in the glory 

that is getting his name in this fine mag. “Asa 

busy VB developer I need quick access to 

good, fast and reliable information. Besides 

being one of the most consistent and compre¬ 

hensive VB sites Carl and Gary’s page sends 

regular “what’s new” updates via an e-mail list- 

serv which is really handy.” 

You’ll find pointers to books and maga¬ 

zines that will help you out, as well as links to 

a whole bunch of other VB-related Internet 

pages. And if you’re looking for a job in the 

US, this is the place to go (though they won’t 

tell you how to get a Green Card). 

http: //www. a pexsc. com/vb 

Visual Basic 

“The most useful technically oriented 

site that I have found is the Windows 95 

Annoyances site,” says Communique 

member, Tony de Sousa “It contains a 

plethora (sic) of useful tips, how-to 

recipes and links to other extremely use¬ 

ful FAQ sites.” 

While it’s hardly the most flattering of 

sites for Microsoft it does contain a heap 

of great ways to make Windows 95 run 

that little bit better and, best of all, it’s based on real 

experiences and has solutions from everyday users. 

Internet 
http: //www. creativelement. com/win95ann 

Adam Crow is a bit of a virtual 

reality fan and recommends the 

Virtual Reality (VR) Association of 

Australia’s Web site. “It points to 

VR companies around the world 

that talk about real products!” 

writes Crow. “I have heard so 

much hype lately. It also seems to 

be creating and promoting new 

technology - imagine that!” 

Internet 
http: //www. vr. org.au/vra 

“I think the most useful technically oriented 

Microsoft Network site that I’ve found so far is 

the Visual Basic Members site,” writes our 

second winner, Communique member 

Andrew Parsons. “This is where anyone with a 

VB problem can go and ask their fellow devel¬ 

opers to help. In fact, it helped my company 

finish a contract successfully rather than fail¬ 

ing dismally.” 

Microsoft Network 
Go word: msvb_sd 

“The Ziff-Davis site on the Microsoft Network 

facilitates access to current information and 

files with an innovative front-end display 

library system,” writes John Massey. “This sys¬ 

tem makes navigation easy for experienced 

and new users seeking review articles and 

shareware files, especially for Windows 95.” 

Microsoft Network 
Go word: ZDNetLibFolder 

In our February issue we asked Commu¬ 

nique members to tell us about their 

favourite Internet and MSN technical sites. 

For their troubles, the first two entries 

below receive a copy of Windows NT Work¬ 

station 3.51 (the others have the pleasure 

of seeing their name and favourite site in 

print). If you’d like to tell us about your 

favourite site, each month we’ll give a Com¬ 

munique T-shirt to the best one and publish 

it in the Tech Road Map. Send your entry 

via e-mail only to “cmq_ed@msn.com". 



Explore and investigate in 
graphs. Visually explore where 
the business is going, with the 
graph that shows it best. 

Capture and share reports. 
Managers can gather important 
reports in briefing books just 
by cutting and pasting. 

Deliver immedi¬ 
ate value. Rank 
top products 
for customers 
in seconds! 
Compare, trend, 
flag exceptions. 
All the functions 
managers want 
are there. 

Analyse from any perspective. 
Examine your data from any 
organisational angle that 
impacts results. Just drag in 
any category you choose from 
the Dimension Line. 

Get to the highlights fast! 
Nothing beats PowerPlay to 
the first answer - or the next! 
Explore large volumes of data 
with unrivaled speed. 

Get the total 
multidimen¬ 
sional picture. 
Organise data 
the way managers 
need it, then 
drill down 
further in any 
direction for 
instant under¬ 
standing. All 
without pro¬ 
gramming! 

Drill down any¬ 
where, anytime. 
Drill down 
instantly on any 
graph to pursue 
the driving fac¬ 
tors below the 
surface. Auto¬ 
matic “hot spots” 
signal more data 
underneath. 

The New PowerPlay 4.1 Gives Managers An Understanding 
Of Their Business They've Never Had Before. 

And An Introductory Price You'll Never See Again. 

CALL 008 8 11 91 

Get PowerPlay® 4.1 now for $495* 

For the first time, give managers across 

the enterprise the total multidimensional 

picture. With PowerPlay 4.1, 

managers quickly explore and 

analyse all the factors driving 

their results. They see critical information 

they’ve never seen before. And you can multi¬ 

ply that impact by putting business intelligence 

on every desktop in the company. 

Call now for your $495 introductory 

copy, and see how PowerPlay revo¬ 

lutionises business reporting and 

analysis. Nothing’s faster to 

evaluate or more cost-effec¬ 

tive to deploy. But don’t wait! 

PowerPlay will change the way your managers 

see your business forever. 

But you won’t see this 

special price for long. Tools That Build Business 

3 

Dealer enquiries phone i.t. ConnXions on 1-800-024-233. 

PowerPlay 4.1. Regular price $995 plus freight. Includes program 

©1994 Cognos Corporation. Cognos and PowerPlay are registei 

> PowerPlay* 



COMMUNIQUE 

Whether you use them to find yourself a partner or 

to provide you with a way of presenting a more 

you 
beauti applications s 

professional image to the world, single Microsoft 

applications such as Word, Excel, Access and 

of four users who, it’s fair to say, have an unusual 

fondness for their application of choice. 
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Excel 95 

Family histories can get quite confusing - just ask anyone who’s tried tracing 

one! Communique asked member Bruce McGowan, one of many Australians 

enthusiastically engaged in filling in all the details of his family history. 

Bruce, though, is probably unique because he’s used Microsoft’s Excel to 

track more than 800 ancestors. 

“I guess I’m like a lot of home users,” said McGowan. “I like to sit in front of 

my computer at home and dream up different ways to do things. I’d rather do 

that than play games - I er\joy working on something.” 

McGowan has produced a comprehensive family tree starting with his 

ancestors in the late eighteenth century in Ireland, covering their descendants’ 

journey out to New Zealand in 1842, and coming right up to today’s members of 

his family. In all it spans about 800 people from many generations of McGowan’s 

family. 

“Basically I wanted to have the family tree set out in a graphical way,” said 

McGowan. “When you’re talking about your family tree it’s necessary to draw 

where people fit in,” he said. “Excel had the graphical ability I was looking for, 

plus it allowed me to fit a lot morPdata into the page than some other applica¬ 

tions I had looked at.” 

The project was a collaborative effort 

between McGowan and his brother, who 

had collected much of the necessary data 

over a year before the project reached the 

computer. Using Excel, the project was 

then complete in just three months. 

tne 

McGowan started out with a 

definite picture of what he wanted 

the program to do, and he found 

that “Excel had the flexibility to 

accommodate that from the very 

first idea”. 

Having the ability to create 

macros in Excel saved McGowan 

an enormous amount of time. He 

used macros to create details such 

as date of birth, birthplace, mar¬ 

riage date, date of decease and 

place of burial for each member of his family tree. Macros were also used to 

make all the information in the tree, which spanned many generations, look uni¬ 

form, with the correct font and point size. 

With the family tree complete, McGowan is now looking at using the power 

of the new 32-bit version of Excel for Windows 95 for new projects. He says, the 

only other way the project could be expanded would be to delve into the details 

of his family in Ireland prior to 1770, which is where his tree starts. 

“If some more information did appear from the mists of time,” said 

McGowan, “it would be a great excuse to make the trip to Ireland!” 
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COMMUNIQUE 

Access 95 Access 
When it comes down to finding a perfect match, the Melbourne-based dating 

agency, Entre Nous, is finding that Microsoft’s Access for Windows 95 is helping 

it improve its success rate. 

Entre Nous’ principal, Rosalind Neville, says she doesn’t need anything as 

trite as Dexter, the robot from the Perfect Match TV show, to give hints on who 

might match her customers. While Access 95 plays its part, it really all comes 

down to good chemistry. 

“Our clients, more than anything else, want chemistry,” says Neville, who 

proudly quotes a success rate of 87 per cent when it comes to introducing cou¬ 

ples. 

To begin the search for companionship, Entre Nous uses the cross-matching 

facilities in Access to arrive at a short list of people who may be suitable for a 

client. It’s possible to search simply on such things as eye colour and height, but 

it’s also possible to be much more specific and include the preferred suburb, 

hobbies, religion, smoking or non-smoking etc. And it’s quite common for clients 

with children to request introductions to other single parents. 

However, the crucial part of finding a perfect match comes when Entre 

Nous’ staff pull up both potential parties’ images from their vast Access data¬ 

base. Surprisingly the single most important thing they’re looking for is similar 

facial features. According to Neville, this is a key criterion to make a more likely 

match. 

“We discovered in the early days that unless the facial features were relative¬ 

ly similar we had Buckley’s chance of there being chemistry between two peo¬ 

ple,” she claims. “Our reputation relies on our getting it right, so this is a very 

important stage.” 

“Our theory is that couples will look for similar features in each other - you 

only have to look at people like Mick Jagger and Jerry Hall with huge lips 

and saucer eyes to see an example of that The hair doesn’t seem to have any 

bearing on the chemistry, nor the colouring, it’s the shape of the face, or the 

actual features. With some couples it’s the way they hold their mouth when 

they smile. It’s hard to describe, but when we see the likeness we know it 

will work.” 

Entre Nous also makes extensive use of Access to record inquiries, track 

the advertising source and also record appointments. Letters are automati¬ 

cally sent out using mail merge through Access and the appointments are 

printed out in advance on a daily roster form for the Entre Nous consultants 

in time to be confirmed 24 hours beforehand. 

When a potential client becomes a client further details are added to the 

Access database, including a Kodak Digital camera image. 

“Everything we do has to be fast,” said Neville. “We’re in a service indus¬ 

try so we’re always in a hurry to get information up on our screens, so we 

can help our clients.” 

According to Neville that’s where moving up to Microsoft Windows 95 

and Microsoft Access 95 has made a significant difference. “It’s a great 

improvement for the client’s sake, because all the information we need is coming 

up faster.” 



from 
Word 95 antiquity 
Rare books and Pacific voyages are the passions of Derek McDonnel. McDonnel 

and his partner, Anne McCormick, have had 25 yeans of studying and purchasing 

all kinds of books and manuscripts, and even paintings, for their business, 

Hordern House, in Potts Point, NSW. 

“We specialise in items from the 16th and 17th centuries,” said McDonnel. 

“And in locating items that are hard to find.” 

According to McDonnel, his is a very research-intensive job, with the need 

for the authenticity of items to be thoroughly researched before being pur¬ 

chased. The results of that research are outlined in detail for both his and his 

customers’ information. 

“It’s very important that we make sure we keep as thorough a description as 

possible of each item and its physical attributes,” said McDonnel. All this docu¬ 

mentation is done using Microsoft Word 95, which integrates with an Access 95 

database used for keeping track of all the items which pass through the book¬ 

sellers’ hands. 

There is a document to accompany each item within Hordern House’s range. 

After purchasing a new item it has to be checked to make sure that it is complete 

and authentic, with all its pages intact and, if appropriate, all its pictures present 

Although readers of the Word 95 catalogue won’t be able to feel the ancient 

paper, or smell the scent of aging pages, it is important for McDonnel to be able 

to fully communicate the rarity of the items within his catalogue to customers. 

With between 3000 and 4000 items in Hordern House’s stock at any one time, 

the demands on his word processor, says McDonnel, are great. New items are 

added continually from his network of connections. Word helps McDonnel and 

his researchers keep track of the vast amounts of information generated on his 

constantly changing inventory. 

Indeed, when there are between 100 and 150 new items or related items the 

book dealers collect all their research notes, descriptions and technical details to 

form a new catalogue. 

“We might decide to do a catalogue focussing on our books from 18th centu¬ 

ry voyages,” said McDonnel. “When we do, it’s just a matter of collating the rele¬ 

vant information in the Access 95 database, kicking it across to Word 95, trans¬ 

ferring it to a floppy disk and sending it off to the printers, together with scanned 

images of the items.” 

If you’re wondering who receives these sorts of catalogues there are around 

4000 individuals on Hordern House’s mailing list and 1000 institutions, including 

museums and galleries all around Australia and the Pacific region, and other 

parts of the world, including for example Sweden. 

Pricing on the items listed in McDonnells catalogues ranges from $100 

through to hundreds of thousands of dollars. McDonnel’s favourite is ‘Journal of 

a Voyage’ printed in London in 1771. 

“It’s the first printed description of Captain Cook’s discovery of the east 

coast,” said McDonnel. “It has an anonymous author because back then sailors 

were not allowed to publish books on their voyages,” he said. This item has a 

price tag of $28,000. 

Derek McDonnel and Anne McCormick... using a new 
writing tool to communicate the value of items created 
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A projector 
that gives 

the clear, bright, uniform 
picture of a computer display 

JVC projectors are made by one of the industry’s true pioneers: 
the Japanese Victor Company. 

JVC in addition to the invention of the VHS tape format set many of the standards 
for today’s professional broadcast industry - and as you would expect, manufacture 
products that continue to set new industry standards. 

The new JVC LX-D300 projector represents a major breakthrough in data and video 
projectors - offering a crisp, clear image in high ambient light conditions. 

With a brightness level of 300 ANSI lumens and a contrast ratio over 200:1, the 
LX- D300 gives uniform image quality from edge to edge, comparing favourably with 
high performance computer display screens. 

It also includes the unique JVC built-in line doubler, that effectively provides twice 
the image resolution and eliminates any jagged lines. And, with the added feature of 
digital keystone correction to remove trapezoidal image distortion, the LX-D300 
gives the setup flexibility you need in varying projection conditions. 

Other key benefits include: 
• Lightweight, portable (9kg), compact design with inbuilt handle. 
• Built-in line doubler to eliminate jagged lines with a low signal to noise 

ratio providing the clearest images possible. 
• Accepts wide range of signal inputs: VGA, S-VGA, Macintosh, composite video, 

S-VHS (Y/Q video and High Definition Television, (HDTV). 
• Easy setup with multi-language on-screen menu. 
• Universal power supply. 
• Infra-red remote control with self-illuminating LttSt! 

keypad supplied as standard. 
• Connection cables for PC and Mac supplied 

as standard. 

Seeing is believing. For an on-site demonstration 
anywhere in Australia or New Zealand, call B & H 
Australia on Feecall 1800 226 436. 

Imported by: ^HAGEMEYER 
Hagemeyer (Aust) B.V. 

Brought to you by: Professional Products Division 

Complete the following and return to: B & H Australia, Reply Paid 22, PO Box 558, St Ives NSW 2075 or Fax (02) 878 0611 

I would like Q A Demonstration Q More Information 

Title_First Name_Last Name_ 

Position_ 

Address_Suburb__ 

State_Postcode_Tel_Fax 

Quality Assured to AS3902. Certificate 783. B&HAustraliaPtyLtdACN003 376145. 



Making 

PowerPoint 95 

With more than half its employees involved in presenting in Australia and around 

the world to clients, industry events and universities, the Melbourne-based com¬ 

pany, The Hiser Group, has used Microsoft’s PowerPoint 95 to present a single, 

strong corporate image. 

This is vital, says Sarah Bloomer, a Principal Consultant at the specialist user 

interface design and usability company. Bloomer adds that user interface design 

is such a new field that the PowerPoint templates have helped reinforce the 

company’s evangelisation of the field. 

Before using PowerPoint, each of Hiser’s consultants created a wide range of 

different-looking presentations. When Hiser began creating a new corporate 

identity midway through last year, it looked for a tool to help it provide a uniform 

way of presenting that identity at the many events its consultants spoke at. 

Enter PowerPoint 95. 

“PowerPoint 95 allowed us to create a series of 

templates that meant when anyone saw a presentation 

from one of our consultants it would be strongly identi¬ 

fiable as a Hiser Group presentation,” Bloomer said. 

“That’s very important for us, because these events are 

marketing opportunities for our company as much as 

anything else. We want people to know that we’re the 

expert in user interface design and how we present 

that message is very important.” 

Hiser works at increasing the usability of software 

through smart interface design and studying the way 

users work. While the result is decreased development, 

training and support costs, what Hiser does is complex 

and at times quite difficult for those unfamiliar with the 

company’s work to understand. 

“We’re using PowerPoint to present ideas and pro¬ 

posals to clients who really don’t have the time to wade 

through thick piles of documents,” says Bloomer. “Get¬ 

ting complex concepts across to our customers or 

potential customers is very important to us, and being 

able to easily and quickly put that together has been 

enormously valuable.” 

Hiser also uses PowerPoint to create mock-ups of 

new user interface designs it has developed for a client 

The ability to create visual prototypes to show clients 

how their ideas will work saves significant develop¬ 

ment time, and allows for client changes during the 

development process. 

“PowerPoint has become pretty fundamental in 

many of the things we do,” Bloomer says. • 
Sarah Bloomer... “We want people to know we’re the expert 
in user interface design and how we present that message is 
very important" 
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Coming! 
Whether it’s news from the 

world’s war zones, a review 

of Brad Pitt’s new movie or 

the latest offering from the 

English band Oasis, by using 

Microsoft’s range of nifty 

Home products you can get 

the latest information, when 

you want it - all without 

moving from your PC. 

Communique launched 

reporter Linda Hopkins into the 

online world to find out how. 

.own 
the 

line si CAR 1A 

The problem with non-fiction books, especially 

reference ones, is that they’re out of date the 

minute they’re printed. Well, thanks to the wonder¬ 

ful world of electronic media, that’s no longer a 

problem. Even super CD-ROM multimedia extrav¬ 

aganzas like Microsoft’s Encarta 96 can be con¬ 

stantly kept up to date. 

All you need is a computer, a CD-ROM drive and 

a modem. Oh yes, and the nifty Microsoft products 

we’re about to tell you about. 

Yes, dear reader, this means that the information 

provided by such gems as Encarta 96, Music Central 

96 and Cinemania 96 no longer begins and ends in 

your “D” drive. The CD is now the interface through 

which you can access up-to-the-minute (well, 

monthly, actually - Ed) information online. 

Update files for Microsoft’s Home products can 

be downloaded from either the Microsoft Network (MSN) or the World Wide 

Web. This means you’ll get the historical context of recent world events, and as 

well as Encarta 96 updates, you’ll be able to read reviews of films and music CDs 

as they’re released rather than waiting a whole year, as with other guides. 

History with bells and whistles 

Now hands up those of you who did your sixth class school project with a 

set of encyclopaedias your parents bought from a door-to-door salesman a cou¬ 

ple of seconds after you were bom. These days CD-ROMs are now taking pride 

of place on bookshelves formerly occupied by those daunting, dusty, volumes of 

knowledge. 

Microsoft’s Encarta 96 Encyclopedia makes learning about the world easy 

and fun. With access to over 7000 articles, over nine hours of sound, and more 

than 100 animations and videos, along with over 900 maps, 8000 images, and 

hundreds of interactive charts and tables to choose from, you can explore 

almost any topic imaginable as you test your knowledge and travel through time. 

With the Encarta 96 Encyclopedia Yearbook Builder, which is available 

online, you can update your encyclopaedia by downloading a monthly Yearbook 



file from the Web or from MSN. And you’ll be able to chat online to other ency¬ 

clopaedia users, as well as the editors and development staff at Microsoft who 

put Encarta 96 together. 

Each Yearbook file you download contains the Month in Review, which 

includes the latest world news and events of the month. You’ll also receive Year¬ 

book Updates, which contain a whole bunch of articles that link into the content 

already on your Encarta Encyclopedia CD-ROM. 

Once you have downloaded the most recent Update file, you can view it in 

one of two ways: by looking at the Yearbook Builder’s Update Browser, or by 

clicking on the Update icon on the title bar within an article which indicates the 

update has been integrated. 

The whole process is easy to follow as help is always only a mouse click 

away, either online or on the CD-ROM. There is also an extensive Frequently 

Asked Questions listing to answer obvious queries like, for example, how this 

information works with the CD product. 

Updates are not the only information you can get from the online sites. 

Besides Encwire (which provides information on a variety of subjects - volca- 

noes was the current topic when we dropped in), 

the site also has a feature called On The Record. 

On The Record takes you to the MSN site on the 

Web where you can take part in a cybercast, a kind 

of online talk show hosted by the journalist Linda 

Ellerbee. These take place live from the @Cafe in 

New York City at 9.30 EST on the third Wednesday 

of eveiy month and (in case you can’t make it) you 

can view the frill transcript of the show online. 

You can take part in the cybercasts by e-mailing 

your questions for the show’s guests, and you may 

need to download some software so you can see 

pictures and audio of the interview as it takes place. 

There is great stuff here that really uses the site and 

the medium of the online world well. 

Action! 

It’s a big ask for a book to contain information 

about a movie that was released after it was printed 

(Dang near impossible, methinks, Linda - Ed), 

or even two months before it was printed for that 

matter. You just have to wait until the next edition of 

the book comes out - and more often than not, 

that’s a year or so later. 

Microsoft’s Cinemania 96 contains a wealth of 

information about great movies and the people who 

make them as well as loads of film reviews by 

famous movie critics like Roger Ebert and Leonard 

Maltin. You’ll not only get access to reviews of thou¬ 

sands of movies, Cinemania 96 can be updated regu¬ 

larly throughout the year. 

Ah, joy! Now you can keep up to date with who’s 

hot and who’s not in that fickle tinsel town called 

Hollywood. 

It’s a cinch to get the updates to Cinemania 96. 

You just click on the Get Connected icon on the 

CD’s contents page and you’re away (helps if you’ve 

got a modem, though!). You can choose to download 

your update files from the Web or the Microsoft Net¬ 

work. 

At the Web site you just click on the Updates 

icon, to download the CD-ROM Monthly Updates 

to find out about the latest films - many before 

their release in Australia. I read all about the new 

science fiction movie, Twelve Monkeys, starring 

Brad Pitt, Bruce Willis and Madeleine Stowe, 
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Part with $157 and you’ll never 
part with your laptop again 

Smart Clips safeguard your laptop or notebook or other 

personal property against loss or misplacement saving you 

time, money, inconvenience and embarrassment. You’ll be 

certain never to lose or leave behind 

your valuable belongings again. 

Attach a Smart Clip to your 

laptop, notebook, or car keys or slip 

a Smart Clip into your briefcase, 

handbag, camera bag or hand-luggage. 

Wear the other Smart Clip on your belt or carry it in your 

pocket. When you move 5-10 metres away (or if your 

property moves away from you) your Smart Clip will 

instantly alert you by audible alarm. 

Smaller than a credit card and surprisingly slim, Smart 

Clips’ unique “paging” facility also allows you to quickly 

locate a misplaced item such as your car keys that may have 

slipped behind the sofa. 

If someone walks away with your laptop, notebook, 

briefcase, handbag, or hand-luggage, the Smart Clip you 

wear or carry will alert you within seconds. 

Manufactured to ISO-9002 quality 

standards by Clipsal in South Australia, 

Smart Clips come as a pair in an attractive 

“snap-close” case with simple instructions 

and a variety of clips and attachments. 

Smart Clips are delivered to you overnight 

complete with a 14 day money back satisfaction 

guarantee and a 12 month Warranty. 

To order have your credit card handy and por sensible 

telephone FREECALL 1800 069 669 today! safe-keeping! 

For TOLL FREE Orders dial 

1800 069 669 
urn 5 ESS 

Another innovative Australian product from Monaad Corporation Pty Ltd. 



weeks before it appeared on 

screens in Australia. 

The Cinemania site on the 

Web, updated each week, has 

much more than reviews of new 

movies. For instance, you can learn that 

Meryl Streep will co-star with Liam Nee- 

son and Julia Roberts in Before and 

After. You can also get to know the stars 

by reading their biographies and you’ll get 

world music, from country to jazz. 

You’ll also find reviews of our departed pals’ 

records, and about 7000 others. There are also 

details on more than 60,000 records, lots of still pics 

and 30 minutes of video clips and film footage. 

How you do it 
Encarta 96 Encydopedia: 

From the CD-ROM you can take the shortcut to 

MSN if you are a registered member, or choose 

to download the files from 
“http://www.microsoft.com/encarta''. 

The updates are part of a free trial service in 

1996, and all the 12 instalments are available, 

even if you get your CD-ROM at Christmas time. 

Cinemania 96: 

Although the CD will say to go to 

Microsoft.com/cinemania, you’ll be re-directed to 
''http://www.msn.com/cinemania” 

to get your updates. 

If you’re a member of MSN, go there instead. 

Music Central: 
http://www.MusicCentral.msn.com or MSN. 

Encarta World Atlas: 

You’ll find Cosmo at 
“http: //www. m icrosoft. com/ewa”. 

Music Central 96 also has biographies of people who have 

^8 contributed a lot to the music industry. There are pictures of thou- 

——■ sands of album covers and lots of in-depth articles and essays on 

musicians, composers, producers and technological innovators. 

There’s also a Suggests feature that will point you in the direction 

of other musicians whose music may be similar to that of musos you 

already know and like. 

Like the Cinemania site online, MusicCentral’s place in cyberspace 

has lots of stuff besides updates to keep you enthralled. 

Updated weekly, the site at the time of writing included an inter- 

m online store 

whose shelves will 

soon be packed 

with 80,000 titles. 

You’ll also be 

able to search 

Music Central’s 

database to track 

down the name of 

Blur’s first album, or 

anything else you 

just have to know 

(like a full list of 

Tom Fogerty’s solo 

records). There is a link to Concert Hotwire, which contains the tour itinerary of 

many bands and lists who is playing at particular venues. 

All ’round the world 
Have you got places to go, people to see? Well, the Encarta 96 World Atlas is 

your passport to the world, its people and cultures. With a determination to 

explore where few of your friends have gone before, the Encarta 96 World Atlas 

is one of the most detailed atlases ever created. 

By clicking on the nifly Locator Globe within World Atlas and by using the 

compass, you can choose to home in on any part of the world. You can go 

behind the scenes to find out more about a place and the people who live there, 

their music, language and daily life. The CD has more than 3000 full-colour pho¬ 

tos of people, cities and the natural world, and it’s possible to view more than 50 

satellite pictures of cities around the world. There are also video clips and pho¬ 

tos of real families in 31 countries. 

Specific information can be found in any number of ways including keyword 

searches to find out something you always wanted to know but didn’t know who 

to ask. Questions like how many camels there are in Saudi Arabia, for example. 

Although this CD-ROM does not have updates online its site on the Web is so 

very special that we had to write about it. Cosmo, the little fellow who lives 

inside World Atlas and whose sole purpose is to make life easy for you on the 

CD-ROM is also your global guide on the Internet 

You can download movies of Cosmo from the site or join his mailing list If 

you do the latter you’ll be among the first to find out about Microsoft’s new 

online services, products, upgrades and additions to the Web site. 

Cosmo also wants you to cruise his favourite Web links to find out the 

world’s political trouble spots, what documents you’ll need on your travels, and 

what the weather will be like when you get there. • 



you want to take 

Tell the kids the 

‘Net is child’s play! 

around the web, don't be led 

up the garden path. If they tell you all you 

need Is a modem, don't believe them. You 

need a modem, software to 

run It and you need an 

account with an' Internet Service Provider. 

In addition, you need other programmes 

that will help you find your way around once 

you get there. Sound hard? Well, it 

doesn't have to be. When you choose a 

Want to know more? Phone toll free 1800 269 950 

Netcomm modem, you get a lot more than 

you expect. Packed in with your modem 

you'll find all the software you 

need to get up and running. 

And, because Netcomm is the Australian 

specialist in remote communications, you 

also get a link to our own Internet service 

provider, Connect.com, and you get access 

to Netscape internet 

navigator software - so it’s 

your "get on the 'Net quick" pack. But, 

more importantly, your new Netcomm 

modem comes with our lifetime warranty* 

and a toll free Customer Support Hotline 

number, because when you choose 

Netcomm, our service doesn't stop when 

you leave the store. So if you have any 

questions, now you don't 

Netcomm Limited - PO Box 379 North Ryde, NSW 2113 Australia. Phone (+612) 888 5533. Fax (+612) 878 7404. Australia-wide Toll Free Customer Support -1800 642 067. 
Email support@netcomm.com.au Web Page http://www.netcomm.com.au 

* 5 year warranty on parts & labour, 5 years + on parts only subject to availability 



Space is a big, black, dark place 

with lots of stars and comets and 

gas and, uhhhh, aliens, yeah, 

aliens!...uh, and spaceships and 

intergalactic wars and...well, it's 

a cool place! 

rhis month the Kids' Communique team 

pulls on its collective space suit, climbs 

aboard that rust bucket of a spaceship, 

CommuniK 13, and takes off for that final cool and 

groovy frontier - space. 

And you can come along too and wander 

around all the places beyond the confines of 

earth's atmosphere! Together we'll discover some 

interesting facts, and have some fun as well...all 

with a little help from a whole bunch of groovy 

Microsoft Home products and a PC known to its 

friends as Compaq! 

Continued on page 2 
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Draw yourself in the cockpit 
and you could win the 

hottest intergalactic battle 

game around - Fury3. 

mere 
yOU^5 

Space isn't just this nice place where 

you can meet cute aliens, visit really 

interesting planets and get to learn 

stuff. It's also a place where you can take con¬ 

trol of a mean and lean fighting machine and 

defend the known universe against all that's 

bad and particularly nasty. 

Yeah, that's more like it! 

Step into the cockpit of the super-fast, all- 

powerful spaceship in Fury3 and you'll soon be 

the hottest pilot this side of Mos Eisley. 

In fact we bet you're sooooooooooooo hot 

that we really want to publish your picture in 

an upcoming Kids' Communique. But we don't 

just want any old picture. We want one of you 

at the controls of your very own Fury3 space¬ 

ship! Yeah! 

All you've got to do is draw yourself in the 

middle of the cockpit (that's the black & white 

picture on this page). Hey, but you don't even 

have to draw yourself. You can cut Ki up a photograph of yourself and 

fplace it in the pic (get Mum's or 

Dad's help if you're a youngun and 

you're going to use scissors). 

The best pic will be published and will win 

a copy of Fury3! Now ain't that easy? 
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ALPHACENTAURI 

BETELGEUSE 

SOUTHERNCROSS 

ECLIPSE 

ORION 

SPACESHIP 

UNIVERSE 

TELESCOPE 

MOON 

STAR 

SUN 

ASTRONOMER 

PLANET 

CRATER 

CONSTELLATION 

COMETS 

SOLARSYSTEM 

OBSERVATORY 

GALAXY 

GRAVITY 

ORBIT 

ASTEROID 

MILKY WAY 

SATELLITE 

SPACESHUTTLE 

APOLLO 

METEOR 

MARINER 

CHALLENGER 

VOYAGER 

SPUTNIK 

MERCURY 

VENUS 

EARTH 

MARS 

SATURN 

JUPITER 

NEPTUNE 

PLUTO 

How to ergjer, 
the 

Want to be a Kids’ \ 

Communique winner? | 

enter any of this month's competi¬ 

tions (they’re marked with a "Win" icon) 

you'll have to get your entries to us before 

Monday May 27,1996. And if you'd like, enclose 

a photo yourself! 

Send your entries to Kids' Communique, 

P.O. Box 222, St Leonards, NSW 2065. Be sure 

to include your name, age, address and 

telephone number. Don't forget we need 

to know your Mum's or Dad's 

Communique number for you 

to be eligible to win. 
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You can write next month's joke simply by 

sending your joke to: 

"Toon's Joke" c/o P.O. Box 222, St Leonards, 

IMSW 2065. Don't forget to include your name, 

age and Mum's or Dad's Communique number. 
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pace makes a good topic for a moviej! 

or a libk, but what is it realty like in 

space?'That's a question people have 

been trying to answer for a long time. It 

wasn't until this century that we even 

worked out how to get to space. Until then 

science was restricted to just looking up at 

the night sky and working out all kinds of 

'Tfratkematical wizardry. 

Microsoft Encarta 96 Encyclopedia can 

take you through the many different excur- 

sions people have made into space since 

those times in rockets and shuttles as part 

of space exploration programs. It also 

explains different space-related concepts, 

such as black holes and relativity. 

^ Wow. I wonder ‘ 
where cosmic rays 

come from? a 

e's heaps of info in Microsoft's 

irta 96 from aardvarks to zoologists. 

Mmrf This month we went 

searching for some 

> : jflHpit space facts from that 

most sP,endid multi 

lri‘''lni • media encyclopaedias. 

t You can 9et y°ur very 
own copy of it for 

S79IERP). 
T^ Cosmic rays are high 

energy subatomic particles 

; from outer space. Where these 

■%' rays come from is not certain. 

■f \ * stars go through ij taS 
changes in their size Ig9 

.V or brightness. A nova is I pS 
. a star whose brightness 1» 

^ suddenly increases before slowly 
.f^Ung (it may continue to exist for 

JSpme time). A supernova is similar, 
J?ut it goes through an explosion 

Which destroys or alters the star. 



in 
Space! 

IPS Radio and 
Space services page 

Here's a heavy-duty site that will 

connect you to lots of great infor¬ 

mation about the way Australia 

monitors sun-related stuff and the 

observatories that do the job. 

Check out the updated readings 

about the ionosphere and geo¬ 

magnetism, or use the articles and 

facts section to find out what all 

these things mean. 

http://www.ips.oz.au 

Views of the 
Solar System 

Take a closer look at the 

planets here! This is as 

close as it gets until 

space travel becomes 

affordable, or you get 

hold of a whopping big 

telescope! This site has 

lots of great reference 

stuff on comets and other space- 

type things too, so look here if you 

have any assignments. Check out 

this picture of the sun. Wooooah! 

http://bang.lanl.gov/solarsys 

The Planetary Society, 
Kids' Warp page 

Here's a hot Net spot (as opposed 

to a sun spot!) that's connected to 

lots of things to do with space-all 

in the name of fun. It's one of the 

very best that we could find, so 

check it out. 

http://planetary.org/tps/kids.html 

SARM 

EVSUN 

REATH 

UREMCRY 

RUPETIJ 

TRUSAN 

PENTNUE 

TOLPU 

AURNUS 

Hey, you could win 

the Magic School 

Bus Explores the Solar 

System for Windows just by 

unscrambling the letters below. 

Now that's easy! 

Friz fans will remember one of the first trips 

on the Magic School Bus was into the Solar 

System to check out all the planets and the 

cool stuff you can do on them. 

If you haven't been into outer space in 

the crazy yellow bus yet you're miss¬ 

ing out, especially as on this 

excursion the school teacher 

goes missing and it's up to 

the kids to find her! (Why 

bother, you ask? Well, Ms Frizzle is 

actually a lot of fun, and the whole 

thing becomes a cool game - so 

there!) 

Unscramble the following let¬ 

ters into the names of the planets 

of our solar system and you could 

win the Magic School Bus Explores 

the Solar System, on CD-ROM for 

Windows. 
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/teybooti’s 
”*Ke’ scanner • • • That'll confuse them 

Or you could tell them the scanner's a keyboard because Compaq's great new 

range of Presario PCs come with an optional keyboard with an in-built scanner. 
It's an exclusive new product from Compaq which lets you type and scan. Guaranteed to 

confuse your parents but great for those school projects and essays. There's also a host of other 
new features on the latest Presarios designed to make computing more fun and heaps easier. 

Now watch their faces when you teil them you're going for a surf on the computer! 

Has it changed y°ur ,i,e yet? 



Because this month it's Mother's Day we thought it 

appropriate to interview one of Australia's best known 

Mums. So Communique's Communiqate correspondent 

was despatched to Shirley Purvis' backyard to interview 

the comedienne under her Hills' Hoist. 

What was your first encounter with technology? 

My JVC Three in One. I could play Xavier Cougar 

on the turntable, listen to Bob Rogers on the wireless 

and watch Ena Harwood on “Beauty and the Beast” 

- all from a single power point. One stop shopping! 
lawn 

Who do you let use your PC? 

I don’t have a personal one as such, but my 12-year-old son Darren has an old 

Amstrad that you start up like a lawn-mower. 

Using 
a 

-mower 
to 

How, if at all, has technology (such as a PC and word processor) 

changed the way you work? 

I have the gadgets no ‘modem-as-tomorrow’ woman could live without But I 

still like to put pen to paper when I write letters of abuse to John Laws. 

compute 
Describe your happiest techo moment. 

We gave my husband, Barry, an electric toilet 

seat wanner for Father’s Day. Obviously it was 

faulty because before you knew it: Woomo! 240 

volts right up the wedding tackle. He’s never missed 

the bowl since. 

What was your most miserable moment with 

your PC? 

Mitzi, our fox terrier, coughed up a furball the 

size of a wombat all over the typewriter bit of Dar¬ 

ren’s Amstrad. The letter ‘Q’ has never been the 

same. Luckily it wasn’t the letter ‘E’, which is far 

more popular with writers, I believe. 

Does your PC have a name - what is it? 

Pile of****! 

If you had an Internet alias (or if you already 

have one) what would it be, and why? 

Gwen Luddite. 

Been surfing lately? 

No way, Jose. I’m a people person. I feel people 

don’t get to know the real me if they can’t hear my 

voice. 

What is your most treasured possession? 

My 1962 Wolseley Six 24/80. No, that’s not my 

PC address, but an automobile built for pure motor¬ 

ing pleasure.# 
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COAMJNIQUE 

PRODUCT TUTORIAL 

This month’s 

Communique tutorial 

has been designed to 

help you with some 

introductory ideas 

about using Microsoft’s 

Access for Windows 

95 and to give you 

some hints for making 

your databases look 

more professional. 

It will help you 

experience some of 

the new features of 

Access 95. In addition 

to what you’ll find 

here there are many, 

many more powerful 

features that can also 

be used to enhance 

your databases. 

Creating 
databases in 
Access 95 » 

By Sue Dyson and Roger McShane 

In this tutorial, you’ll learn how to: 

Q CREATE A DATABASE 

0 LINK TABLES IN A DATABASE 

0 CREATE A SWITCHBOARD FORM 

0 USE COMMAND BUTTONS 

TO JUMP TO A FORM 

0 CREATE A FORM THAT IS 

DISPLAYED ON STARTUP 

Instead of creating the data from scratch, you’re going to use some 

of the data from the North Wind sample database supplied with 

Microsoft Access 95. You’ll then modify the table you copy and then 

create a table of your own and link it to the original table. 

You’ll go on to create some forms and use a special add-in to 

create a Switchboard that will be displayed whenever you open your 

database. Switchboards or ‘navigation forms’ are ideal for inexperi¬ 

enced users. 



CREATING YOUR 
DATABASE 

The NorthWind database can be 
found in the sub-directory of the 
Access directory called Sample. 

D Start Access, then from the initial 
dialog box choose Open an Exist¬ 
ing Database, then select the North- 
Wind database and then choose 
OK. (Note that you might need to 
choose More Files from the list dis¬ 
played to find this database.) 

O If the NorthWind welcome screen 
is displayed then choose OK. 

o Select the Tables tab, then select 
the Suppliers table. 

Q From the Edit menu choose Copy 
or hold down CTRL and press C. 

You’ve now copied the defini¬ 
tion of the table and the data in it to 
the clipboard. 

HI From the File menu choose Close. 
This has closed the NorthWind 

database. You’re now going to cre¬ 
ate a new database and then paste 
the table you’ve copied into it 

Q From the File menu choose New 
Database. 

The New window is displayed. 

Q Make sure that the General tab is 
selected, then select Blank Data¬ 
base, then choose OK 

You need to name the database. 
The File New Database dialog box 
is displayed. 

□ Enter the filename Suppliers, then 
choose Create. 

A blank database with the 
name Suppliers is created. 

The database window is dis¬ 
played. 

Q Select the Table tab, then from the 
Edit menu choose Paste. 

The Paste Table As dialog box 
is displayed and the Structure and 
Data option should be selected. 

EH Enter the name Suppliers in the 
Table Name field, then choose OK 

The table is created. You’re now 
going to inspect the data. 

ID With the Suppliers table still select¬ 
ed, choose Open. 

The data are displayed. Inspect 
the data so you are familiar with 
the contents of the table. 

ED Close the window. 
You’re now going to create an 

extra field. 

EH Choose Design. 

E0 Click in the first blank field in the 
Field Name column and type Relia¬ 
bility Code. 

EH Close the Suppliers table and 
choose Yes to save the changes. 

CREATING A TABLE 

You’re now going to create a new 
table which will hold codes de¬ 
scribing the reliability of suppliers. 

D Make sure that the Tables tab is still 
selected, then choose New. 

PI Choose Design View, then choose 
OK 

O Add fields called Reliability Code 
and Description. Leave them as the 
default Text type. 

Q Select the Reliability Code row and 
then make this field a primary key 
by clicking on the Primary Key but¬ 
ton. 

El Close the Thble window and save 
the table with the name Reliability 
Codes. 

Before entering any data you’re 
going to define the relationship 
between the two tables. 

Online resources 
You’ll find Microsoft’s Web site 

has lots of Access 95 information. 

Also check out Microsoft’s Web 

support area for hints and tips on 

how to get more from the soft¬ 

ware. 

Internet 
http: //www. microsoft.com/ms 
access 

DEFINING 
RELATIONSHIPS 

D From the Tools menu choose Rela¬ 
tionships. 

The Relationships window is 
displayed along with the Show 
Table dialog box. 

PI Add both the Reliability Code and 
Suppliers tables to the window and 
then choose Close. 

Make sure that you can see all 
the fields in each table. 

O Click in the Reliability Code field in 
the Suppliers table and drag to the 
Reliability Code field in the Reliabil¬ 
ity table. 

The Relationships window is 

Q Choose Create. 
You’ll see the relationship dis¬ 

played graphically. 

El Close the Relationships window 
and save the changes. 

You’re now going to create a 
form so that you can input the data 
for the Reliability Code table. 
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COMMUNIQUE 

CREATING THE FORM 
AND DATA 

O Switch to the Forms tab and select 
New. 

0 From the New Form window, 
choose the AutoForm: Columnar 
option, then choose the Reliability 
Codes table from the drop-down 
list, then choose OK 

A form is created automatically. 
Enter the following codes and 
descriptions. 

Code Description 

VG Always supplies 

promptly 

GD Usually supplies 

promptly 

SU Sometimes unreliable 

PR Poor reliability history 

DN Do not use 

0 Close the form and choose Yes to 
save the changes. 

You’re now going to create a 
form to help you maintain the Sup¬ 
pliers table. 

Q Select the Forms tab and select 
New. 

0 Choose the AutoForm: Columnar 
option, then choose the Suppliers 
table, then choose OK 

Once again, a form is created. 
One problem with this form is that 
you currently have to type the Reli¬ 
ability Codes into the form. Your 
data input would be more reliable if 
you chose the codes from a list. At 
present the field is a Tfext Box. 

Q Save the form with the name Sup¬ 
pliers Data Input Form. 

0 Before you start, select the Suppli¬ 
ers Data Input Form, then choose 
Design. 

CREATING A 
DROP-DOWN LIST 

Q Right-click on the Reliability Code 
field (not the label), then choose 
the Change To option. From the fly¬ 
out menu choose Combo Box. 

0 Right-click again, then choose 
Properties from the pop-up menu. 

0 In the Control Source field type: 

Reliability Code 

if it’s not already there. 

Q In the Row Source Type field 
choose the Table/Query option. 

This indicates that the data to 
be presented in the drop-down list 
will be derived from a table or 
query. 

0 Type Reliability Codes in the Row 
Source field. Also set the Column 
Count field to 2 and the Column 
Widths to 0.5 cm. 

0 From the View menu choose Form. 
You’re now returned to the 

Form view where you can enter 
data 

0 Select a Reliability Code for a few 
of the suppliers by clicking on the 
drop-down list and selecting a 
code. 

Notice that when you click on 
the drop-down arrow, you see the 
two columns of data When you 
click on one of these, the code is 
returned to the field. 

0 Close the form and save the 
changes to the design. 

Now that you’ve created the 
data, you’re going to create a 
‘Switchboard Form’ from which 
you can select either form for data 
maintenance. These forms are ideal 
for novice users who simply want 
to select from menus rather than 
having to navigate by choosing 
from tables, queries and forms. 

Tons of Tutorials 
More than a year’s worth of Tutor¬ 

ials, along with Hot Tips, Ask the 

Wiz items and Tips and Techniques 

are available on the Communique 

Power Base CD-ROM. You can get 

hold of your very own copy for just 

$30 (plus $9.95 postage + handling) 

if you’re a Communique member. 

To order yours today simply fill out 

the form between pages 48 and 49, 

or ring the Sales Information 

Centre on 1-800 257 253 

or (02) 870 2111 in Sydney. 

CREATING A 
‘SWITCHBOARD FORM’ 

0 From the Tools menu choose Add¬ 
ins, then from the fly-out menu 
choose Switchboard Manager. 

The following message is dis¬ 
played: 

0 Choose Yes. 
The Switchboard Manager dia¬ 

log box is displayed. There will only 
be one entry in the Switchboard 
Pages list. 

0 Choose Edit. 
The Edit Switchboard Page dia¬ 

log is displayed. Here you can nom¬ 
inate the ‘jumps’ you want to make. 
You’re going to specify the two 
forms that you’ve just created as 
the items that they can jump to. 
You’re also going to provide an 
option for exiting from the data¬ 
base. 

0 Choose New. 
The Edit Switchboard Items 

dialog is displayed. 

0 In the Text field type ‘Maintain Sup¬ 
plier Information’. 

0 From the Command drop-down list 
choose Open Form in Edit Mode. 

0 From the Form drop-down list 
choose Suppliers Data Input Form, 
then choose OK 

0 Repeat steps 4 to 7 to create an 
entry for the Reliability Code form 
(enter Maintain Reliability Codes in 
the Text field). 

0 At the Edit Switchboard Page dia¬ 
log choose New. 

The Edit Switchboard Items 
dialog box is displayed. 



FTfl Enter the text Exit from Database 
in the Text box. 

iTl From the Command drop-down list 
choose Exit Application, then 
choose OK 

|0 Choose Close twice to return to the 
Database window. 

Now one problem that remains 
is that the Switchboard form isn’t 
displayed automatically. You’re 
now going to ask for it to be dis¬ 
played whenever you open the 
database and you’re also going to 
minimise the database window. 

DISPLAYING A 
FORM ON STARTUP 

Q From the Tools menu choose Start¬ 
up. 

The Startup dialog is displayed. 

O In the Application Title field type: 

Suppliers' Database 

O From the Display Form drop-down 
list choose Switchboard. 

Q De-select the Display Database 
Window option, then choose OK 

Q From the File menu choose Close 
to close the database. 

Q Now open the database again (the 
name should be in the recently 
used file list at the bottom of the 
File menu). 

Notice that the Switchboard 
form with the three options you 
created is displayed. 

Hint: 
To bypass the Startup 

option settings, 

hold down the SHIFT key 

while opening the database. 

RETURNING TO THE 
SWITCHBOARD 

You’re now going to do one 
more small piece of ‘tidying up’. 
When you’re finished with a form, 
you’d like to return to the Switch¬ 
board. 

D From the main Switchboard, 
choose the Maintain Suppliers’ 
Information option. 

The Suppliers Data Entry Form 
is displayed. 

WM From the View menu choose Form 

There’s a blank area to the right 
of the form where there’s room to 
place a button. 

El Make sure that the Toolbox is dis¬ 
played. If it isn’t visible, choose 
Toolbox from the View menu. 

Q Select the Command Button from 
the Toolbox, then drag a control on 
the form. 

The Command Button Wizard 
is displayed. 

lil From the Categories list choose 
Form Operations, then from the 
Actions list choose Close Form, 
then choose Next. 

Q At the next screen choose the Pic¬ 
ture option, then choose the Exit 
option, then choose Next 

B At the next screen type the name 
Exit Form, then choose Finish. 

A button with a picture of an 
open door is displayed. 

O Right-click on the button, then 
choose Properties. 

Q Select the Event tab. 
Notice that there’s an On Click 

procedure that’s been created by 
the Wizard that you just ran. 

rm Click in this field, then click on the 
Build button to the right of the field. 

The code that’s has been creat¬ 
ed is displayed. You will see the 
command DoCmd.Close among the 
lines of code. 

rtl Click at the end of this command 
then type the following: 

DoCmd.OpenFom "Switchboard" 

fFl Now close the Module form. 

[0 Close the Supplier Data Entry 
Form and choose Yes to save the 
changes. 

You can repeat this for the 
other form if required. 

CONCLUSION 

You should now close the data¬ 
base by selecting the Exit button, 
then start it up again to test that 
everything works correctly. 

There are plenty of places to learn ^ 

about Microsoft’s zippy Access for 

Windows 95. Among them, perhaps q 

the best are Microsoft Press’ range of _q 

books which provide easy-to-follow ^ 

tutorials and hints on getting the most 

from your software. i. 

If you’re running Access 95 try Q- 

Microsoft’s Access for Windows 95 .-M 

Step by Step book. It’s a whopping 352 O 

pages and it’s aimed at both beginners q 

and intermediate users. You’ll find six- L. 

teen quick, easy lessons that take you 

from understanding data basics to cus- 

tomising reports and forms. Exercises qj 

and practice files are built around a ^ 

business-oriented scenario. 

ERP $59.95. For more information on M 

this and other Microsoft Press Books fl) 

and the location of your nearest retail £ 

outlet, call Woodslane on O 

1-800 655 423. & 
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"I have to smile when 

I look back on our 

presentations before 

we started using Litepro. 

As MIS professionals, 

we really presented 

information in a 

remarkably 

unprofessional way!" 

Cumbersome hand drawn charts for a start - not to 

mention pin men and spidery writing on 

whiteboards, and featureless overheads that looked 

as though they'd been blown together at the last 

minute - and quite often had! 

Then there were the carousels carrying huge 

numbers of slides - which always seemed to get out 

of order. 

Our projection equipment was another disaster 

area. When it broke down during a presentation on 

the implications of the Internet, I felt a laughing 

stock - using unreliable and dated equipment to tell 

our senior managers about a revolutionary 

development in advanced information technology. 

Then we heard about Litepro, and after one 

demonstration we realised that Litepro was a 

revolution in presentation technology - totally 

outdating traditional methods. After hiring a unit, 

our presentations underwent a transformation of 

mega proportions. 

You see, instead of using slides and overheads, 

Litepro enables you to design high impact colour 

images. Once you've plugged Litepro into your 

computer, your presentation can use video material 

and computer visuals - including photo quality 

scanned images. 

ELECTROBOARD gave us a training course, and 

we were amazed at how easy it was to operate - 

within a very short time, we were all much more 

relaxed about presentations, and making a miles 

better job of them as a result. 

What we found even more amazing was that 

such phenomenal presentation power could fit into 

an easy-to-carry lightweight compact case. 

Needless to say, we've now purchased our own 

Litepro unit, and we're about to order a second one. 

1 800 622 880 
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Edited by The Wizard 

Ask our very own code sourcer- 
er to wave the wand and bring 
light where there is darkness. 
If you’re bothered by Basic, 
exasperated by Excel or wound 
up by Word, Ask the Wiz. 
Send your problems to: 

The Wiz 

c/oGP01793 
Hobart 7001 

Windows 95 - Using 

Internet Assistant 

DEAR WIZARD 
Just recently I downloaded Internet 
Assistant for Microsoft Word 6.0 from 
MSN. I’ve been practising by creating 
some Web pages and I must say it’s 
easy to use. How do I use my own 
‘fancy’ text with colour and centring 
it? I tried but it doesn’t show when I 
try in Inet 2.0. 

How do I create big links using GIFs 
like the MSN Home Page. In the MSN 
Home Page they have the big title on 
the home page. The whole thing has 
different links using the same picture. 
How do I create that? 

Jongkon Ratanavaraha, 
Labrador, Qld. 

The Wizard replies: 
Internet Assistant version l.Oz is 
designed for use with Word for 
Windows version 6.0 and Internet 
Assistant 2.0z is designed for use 
with Word 95. 

If you centre text or choose a 
coloured font in Version 2.0z and 
save the document as HTML, your 
formatting will be retained. The 
only problem is that you need to be 
using Word 95. 

Alternatively, you can choose 
not to convert your Word docu¬ 
ment to HTML format Using Inter¬ 
net Assistant l.Oz, you can create 
hyperlinks in Word documents 
which are preserved when the doc¬ 
ument is saved with its standard 
.DOC extension. Microsoft pro¬ 
vides Microsoft Word Viewer free 
of charge which people without 
Word can use to view and print 
Word documents. 

Just in case you decide to 
upgrade to Word 95, here’s some 
advice on how to insert a clickable 
graphic into an HTML document 
using Internet Assistant 

For a graphic to be clickable it 
must have the attribute ISMAP and 
it must have an associated map file 
(called the ISMAP file). The ISMAP 
file contains the definition of the 
hyperlinks that will be activated by 

clicking on any part of the graphic. 

You can set the ISMAP attribute 
in Internet Assistant but you cannot 
generate the map file. You’ll need to 
use a third-party tool to create it 
and need to consult with the man¬ 
ager of your Web server. 

If you have a graphic for which 
you also have an ISMAP file, you do 
the following in the Internet Assis¬ 
tant to insert the graphic, set the 
ISMAP attribute and define the 
location of the map file. 

Remember that to test this your 
document must be based on the 
HTML template. Otherwise, you’ll 
see Word’s standard Insert Picture 
command. 

if From the Insert menu choose Pic¬ 
ture. 

You’ll see this dialog box. 

if Choose Browse, then locate the 
ISMAP image you want to insert, 
select it, then choose OK to insert it 
into the document 

it In the Alternative Text box, type 
the text you want to be displayed if 
a reader chooses not to view graph¬ 
ics. 

ft Click the Options tab and select the 
Image Is a Sensitive Map check 
box. 

The dialog box should look like 
this: 

if Click OK. 

ft Select the image you just inserted. 
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On the Insert menu click Hyperlink. 

it In the File or URL box, type the 
URL of the map file associated with 
this image. 

Windows 95 - Downloading 

latest version of Internet 

Explorer 

DEAR WIZARD 
I have Microsoft Plus! but haven’t 
installed its Explorer yet. I’m getting 
information that one can download 
Explorer 2.0. Are they one and the 
same or is it a later version? 

David Barnett, 
Drummoyne, NSW. 

The Wizard replies: 
The version of Internet Explorer 
which is available for downloading 
is later than the version distributed 
with Microsoft Plus! There’s no 
need to install the old version. Sim¬ 
ply follow the instructions in MSN 
to get access to the Internet and 
download the Explorer. 

You’ll also need to: 
• At MSN, double-click on Member 

Assistance. 
• Double-click on Beta Internet 

Access. 
• Double-click on “Important!! 

Read Me First!” (how could you 
avoid it with all those exclama¬ 
tion marks?). It’s a good idea to 
choose Edit file and then save this 
document so that you can refer to 
it later. It contains clear instruc¬ 
tions on what you have to do to 
upgrade to the latest version of 
MSN (if you haven’t already) and 
to obtain the Internet Explorer. 

You can also double-click on 
Getting on the Internet for more 
information about what you have 
to do. 

Follow all the instructions in 
“Important!! Read Me First!” to 
download the latest version of MSN 
(if needed), change your MSN set¬ 
tings, log on and download the 
Internet Explorer. 

Windows 96 - Faxing using 

Microsoft Exchange 

DEAR WIZARD 
On my portable computer I can’t 

get my phone numbers (nor my phone 
dialler) to work correctly with long 
distance phone numbers. I have three 
Dialling Properties/My Locations set 
up, two in one area code and one in 
another. 

Only one of these locations 
(‘Work’) has a zero entered into the 
‘How I dial from this location/To 
access an outside line’ section. 

All my phone numbers are entered 
in the international format (for exam¬ 
ple, +61 (02) xxx xxxx). From work 
things are fine, but from anywhere 
else the dialler always enters an addi¬ 
tional zero as if I’m dialling from work. 
I’ve tried removing the outside line 
access code from my work location 
properties when I’m away from work 
but the recalcitrant zero still appears. 
I’ve tried entering numbers without 
the preceding zero. This works when 
dialling within the same area code but 
not when dialling into another area 
code. What am I doing wrong? 

Another problem. 
I always send faxes from within 

Microsoft Word 7.0 by choosing the 
Microsoft Fax printer. When there are 
no problems it all works very well. 
However, when something goes 
wrong and the fax can’t be sent (e.g. 
I’ve put in the wrong number) I get 
stuck. I can start Microsoft Exchange 
and select the fax, but I can’t find any 
way to Send Now from within 
Microsoft Exchange (to force it to try 
again, if that’s what I want) and I can't 
find out how to change the fax num¬ 
ber within Microsoft Exchange on a 
fax that’s waiting to be sent. If I send 
the fax again from within Word with 
the correct number, the new fax sim¬ 
ply queues up. My solution is to 
reboot. What am I doing wrong? 

Austin Adams, 
Sydney, NSW. 

The Wizard replies: 
The international telephone format 
requires that you omit the first zero 
of the STD code. For example, if 

you are creating a dialling location 
for Sydney, the dialog box should 
look like this: 

Notice that the area code is 2 
not 02. If you are creating a dialling 
location for Hobart, you would type 
02 because the area code is 002. 
Windows 95 will add the starting 0. 

To solve the second problem, 
tiy using the Send command in the 
File menu to send your faxes 
instead of printing using Microsoft 
Fax. You don’t need to start up 
Microsoft Exchange first, but if 
something goes wrong it seems to 
be easier to get out of it if 
Exchange is already running. To 
start Exchange, click on Start, then 
Programs, then Microsoft 
Exchange. 

Then return to Word ready to 
send your document. It’s also not 
necessary to save the document 
before you send the fax but the 
Wizard’s golden rule is that you 
should always save before you 
print or fax. 

Now, with Exchange opened 
and your document safely saved, 
choose File, then choose Send. 

After a few moments, you’ll see 
a dialog box that looks like this: 

Click on the To icon, then select 
the name from your personal 
address book or, if it’s a new recipi¬ 
ent, choose New, then enter the 



receiver’s fax details. Choose OK 

Now click on the Send icon. If 
all goes well, your fax will be ‘print¬ 
ed’ then sent. 

If there’s a problem (for exam¬ 
ple if the telephone number is 
wrong) and the fax can’t be sent, 
select Microsoft Exchange which 
should be available on the taskbar 
if you started it before you began 
faxing. Depending on the cause of 
the problem, you may find a mes¬ 
sage in the Inbox from the System 
Administrator which includes the 
unsent fax or the fax might still be 
in the Outbox. 

From either Folder, double¬ 
click on the fax message. You can 
now change the recipient details 
(e.g. choose a different recipient or 
change the fax number for this 
recipient). To change the fax num¬ 
ber, click on the To (or Resend To) 
button, select the recipient from 
the list in your personal address 
book, then choose Properties. 
Change the number and then 
choose OK until you return to the 
New Message dialog box. Then 
click on the Send icon again. 

Word 6.0 -Automatic 

numbering 

DEAR WIZARD 
I’m wondering whether Word 6.0 has 
a feature that enables a document to 
have certain areas within it automati¬ 
cally increasing by one numeric at 
each point. 

Each point is preceded by the year 
(within brackets) e.g. (96/—). 

Can you help? 
' v Debra Wilson, 

Mallala, SA. 

The Wizard replies: 
The answer is to use the Seq 
(Sequence) field. Although it’s not 
been as important since the advent 

of Word 6.0 with its more powerful 
bullets and numbering features, it 
still has its uses and should be ideal 
for you. It’s well suited to automatic 
numbering where the numbers 
aren’t at the start of a paragraph or 
don’t immediately follow one 
another. 

Decide on a name of your 
series of numbers. For example, 
you might call it “point’ because 
each time you increment the num¬ 
bers you’re going to make a new 
point It doesn’t matter what name 
you choose but normally you 
should choose a name that’s related 
to the task the series is performing. 

Then do the following each 
time you want a number to appear. 

☆ Press Ctrl+F9 to insert a field. 

it Inside the field parentheses, type: 

seq point 

or whatever other name you chose. 

it Press F9 to update the field con¬ 
tents. 

You’ll see a number, 

it Repeat the same procedure again 
further down the document and the 
number will be incremented by 1. 

That’s the solution but there are 
ways you can speed up the process 
of creating each field. 

One method is to record a sim¬ 
ple macro which uses a keyboard 
shortcut, a menu command or a 
toolbar button to insert the field. 

Try the following: 

it From the Tools menu choose 
Macro. 

☆ Type a name for the macro, then 
choose Record. 

You’ll see this dialog box. 

Click on Keyboard to assign the 
macro to a keyboard shortcut. 

(At this point, you could assign it to 
a menu or toolbar instead. If you do, 
the next few steps will be different.) 

it Type the keyboard shortcut you 
want to use, for example 
Ctrl+Shift+O. (Notice that if the key 
combination is already assigned to 
another function you’ll be shown 
what it is. Otherwise, Word tells 
you that the key combination is 
unassigned.) 

it Choose Assign, then choose Close. 

You’re now recording the macro. 

■fr Now repeat the procedure you’ve 
just learned to insert the field. 

it After you’ve pressed F9 (but while 
still recording), press the right 
arrow key so that the insertion 
point moves past the number. If 
you know you always want a space 
or a tab after the number you could 
then type the space or the tab. 

it Now either click on the Close but¬ 
ton on the Record Macro Toolbar 
or choose Tools, then Macro, then 
Stop Recording. 

it To test the macro, type the key¬ 
board shortcut two or three times. 

A couple of extra hints: 

If you want the sequence of 
numbers to start at a number other 
than 1, for the first number in the 
sequence add the \r switch. It 
should look like this: 

seq point \r 9 

where the 9 in this example is 
the number you want to start with. 

When you have seq fields in a 
document, it’s always a good idea, 
just before you print, to select the 
whole document (e.g. by pressing 
Ctrl+A) and then press F9 to 
ensure that all fields are displaying 
the correct number. Alternatively, 
set your Print Options to include 
Update fields (by choosing Tools 
from the Options menu, choosing 
the Print Tab, putting a check box 
beside Update Fields and then 
choosing OK). Then all fields will 
automatically be updated each time 
you print. 
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Bring your software to life with 

an Intel Pentium* Processor. 

With an Intel Pentium® processor inside your PC, you have 

the power to really bring your software alive. 

A Pentium processor-based PC will make light work of 

everything from the most complex business packages to the 

latest multi-media games, as well as being a powerful way 

to access the Internet. 

For information on an Intel Pentium processor-based PC call, 

into your nearest retailer, or visit the Intel Web 

site at http://www.intel.com/procs/pentium/ ® 
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Sue Dyson 

and 

Roger McShane 

GET YOURSELF 

A T-SHIRT! 
All suppliers of Hot 
lips published in 

Communique get a 
T-shirt. Address your 
tips to Hot Ups, 
GPO1793 Hobart 7001. 

Of course, you must be 
a member, so please 
include your 
Communique number! 

WINDOWS 95 
- ACCESSING THE DESKTOP 
In the February 1996 Communique 
Muhith Masih inquired about 
accessing the desktop while running 
applications in Windows 95.1 have a 
different way of doing this that I find 
very handy. 

O From the Desktop, open My Com¬ 
puter by double-clicking on it. 
(Note: You may, of course, change 
its name. It’s the icon 
that should look like this:) 

0 Ensure that the toolbar is 
displayed by choosing the View 
menu then Toolbar. 

My Computer is displayed by 
default in the folder drop down list. 

© In the drop down list, scroll up and 
select Desktop. 

The window is now titled Desk¬ 
top and the Desktop icons are dis¬ 
played. 

© Rearrange the icons in the Desktop 
to suit you and resize it so that you 
can see them all. 

0 Click on the Minimize button to 
minimize the Desktop window. 

It appears as an icon on the 
taskbar. 

0 To access the Desktop, click once 
on the Desktop taskbar button. 

0 When you’ve done what you want¬ 
ed, minimize the Desktop again. 

Ensure that the Desktop icon is 
displayed in the taskbar when the 
computer is shut down or the user 
logs off. When the computer is next 
started or the user next logs on, the 
Desktop icon will be in the taskbar 
ready for use. 

A great source of Windows 95 
information for Web surfers is 
“http://www.netex.net/w95”. 

Shone Knight 
Bray Park, Qld. 

WINDOWS 95 
- ACCESS TO THE DESKTOP 
The answer the Wizard gave in the 
February Communique was one 
way of accessing the Desktop and, 
although it has the advantage of 
showing the complete Desktop, it is 
annoying to have to minimize all 
applications. 

There are other options. The 
way I have found the simplest and 
best is to make a shortcut for the 
Desktop folder (located inside the 
Windows folder) and then put this 
shortcut into the Startup folder. (To 
get access to the Startup folder so 
you can drag the shortcut into it, 
right-click on the Start button, 
choose Open, then Programs, then 
Startup). 

If you have the toolbar visible 
single-click on the Desktop shortcut 
and click on the Properties icon. If 
the toolbar isn’t visible, right-click 
on the Desktop shortcut then 
choose Properties. Choose the 
Shortcut tab and in Run, choose 
Rim Minimized. 

The dialog box should look like 
this although the path name dis¬ 
played will vary depending on 
where Windows 95 is installed: 

Choose OK. 
From then on, you always have 

access to the Desktop data from 
your taskbar. 

Anne Bradley, 
City Beach, WA. 

Editors’ Note 
Shane’s and Anne’s methods 

are excellent alternatives, espe¬ 
cially if your taskbar gets clut- 



tered and it’s hard to find an 
empty spot to right-click on. 
However, right-clicking on the 
taskbar and choosing Minimize 
All Windows is very easy and you 
can easily restore the previous 
state by right-clicking again and 
choosing Undo Minimize AU. 

@ 3$ 

PUBLISHER 2.0 
- PRINTING OUTLINE TEXT 
In the past I have had to make up 
posters for fetes etc. Publisher is 
great for doing this. I choose custom 
paper to suit the cardboard that I 
have to use then do the layout. 

Printing out solid text 15 cm 
high can be a bit expensive on my 
ink-jet and it limits me to black and 
white. So I use Publisher to produce 
an outline of the text that I can then 
colour as I want. 

Enter the text in Word Art by 
clicking on the WordArt icon, typing 
the text, then closing the Enter Your 
Text Here dialog box. 

Click on the Shading button on 
the WordArt Toolbar (the . , 
left-most one in this group )■ IW0'" !l 

Choose White (which is the sec¬ 
ond choice in the first row), then 
choose OK. Your WordArt text is 
now reversed. 

Click on the Line button on the 
WordArt Toolbar (the right-most 
button on the WordArt Toolbar). 
Select a line width to suit, then 
choose OK 

Your WordArt is now in outline 
form. 

Print out your completed poster 
using tiling. Then use this document 
as the master copy to trace on to the 
card. Colour in as desired and peo¬ 
ple will admire your sign-writing 
ability. 

Greg Jones. 
Gympie, Qld. 

Editors’ Note 
If you’re using Publisher 95, 

you can choose a custom paper 
size using the File Page Setup 
command. If you’re using Pub¬ 
lisher 2.0, choose the Page menu, 
then choose Page Setup. Choose 
Special Size, then enter the cor¬ 
rect page length and page width. 
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WORD 6.0 - FULL SCREEN MODE 
I was very interested in Darryl 
Bates’ Hot Tip in the December/Jan- 
uaiy Communique on Word 6.0 
scroll bars in Full Screen mode. I 
attempted to duplicate his proce¬ 
dure but found that the Full Screen 
Toolbar was missing when I was in 
Full Screen mode. This led to trawl¬ 
ing through the Help system and 
finally the manual where I found a 
much easier and more versatile way 
to customize the Full Screen view. 

First, switch to Full Screen 
mode by choosing it from the View 
menu. 

Then choose the View Toolbars 
option. You can do this in Full 
Screen view by typing Alt, V, T. The 
Toolbar appears and it now includes 
the Full Screen Toolbar. (This is 
missing if you choose Toolbars in 
Normal view.) Now you can choose 
to display or hide any of the toolbars 
on this list. Then choose OK What¬ 
ever you choose applies to Full 
Screen view only and does not 
affect your setup in Normal view. 

Now choose Tools Options by 
typing Alt, T, O. Select the View tab. 
Here you can choose the Status Bar, 
Horizontal Scroll Bar, or Vertical 
Scroll Bar. Then choose OK Once 
again, the setting of these options 
only affects Full Screen view. 

To have the ruler visible, type 
Alt, V, R. This will toggle the ruler on 
and off for Full Screen view only. 

All the rest of the normal com¬ 
mands on the View menu are avail¬ 
able in Full Screen mode. You can 
choose Alt, V, O for Outline view, 
Alt, V, M for Master Document view, 
Alt, V, H for Header and Footer view 
and Alt, V, OR for Zoom. However, 
these options remain in effect when 
you switch back to Normal view. 

Natalie Wood. 
Willoughby, NSW. 

Editors’ Note 
When you are in Full Screen 

view, as well as using keystrokes 
to choose menu options, you can 
move the mouse to the top of the 
screen and then click once with 
the left mouse button. The closest 
menu will drop down. 

Natalie Wood... finding tips in full action mode 

EXCEL 5.0 - RENAMING SHEETS 
In the November 95 edition of Com¬ 
munique Hot Tips the editors 
described how to rename a sheet by 
right-clicking on the Sheet tab and 
choosing the Rename command. 

There’s a simpler way. Double¬ 
clicking (using the left mouse but¬ 
ton) will instantly bring up the 
Rename Sheet dialog box. 

Phillip McKay, 
Silvan, Vic. 

Hordes of Hot Tips 
More than a year’s worth of Hot 

Tips, along with Tutorials, Ask the Wiz 
items and Tips and Techniques are avail¬ 
able on the Communique PowerBase 
CD-ROM, for only $30 (plus $9.95 
postage + handling) to Communique 
members. 

Order your copy by filling out the 
form between pages 48 and 49, or ring 
the Sales Information Centre at 1-800 
257 253 or (02) 870 2111 within Sydney. 
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Offer 

of the month 

Just plug 
Snapshots 
QuickCam is described as the first afford¬ 

able fully digital camera for personal 

computers and laptops. It plugs directly 

into the parallel port of your PC, and with 

the easily installed QuickPict and Quick- 

Movie software, you can see your own 

images on almost any Windows program 

in minutes. 

You can take pictures of your own, 

or use the QuickCam to digitise photos 

you already have. Liven up business 

plans, newsletters, cards and personal 

notes with your own snapshots. That’s a 

versatile alternative to using someone 

else’s clip art. 

QuickCam also makes black and 

white videos using direct digital imaging. 

Connectix QuickMovie software makes it 

easy to capture your movies using 

Microsoft Video for Windows, so you have 

everything you need to make 

movies with your computer. Imag¬ 

ine adding a video clip with a 

product demo to an otherwise dull 

presentation or e-mailing family 

videos to remote relatives. Used 

with a soundboard and micro¬ 

phone, you’ll have full audio and video. 

QuickCam comes with a 6ft connect¬ 

ing cable and keyboard power adaptor, 

and a camera base. Included with the digi¬ 

tal video camera is a live-action full-size 

screen-saver to run on your screen while 

you’re not working. 

in for 
and Video 

) i 

Put smiles on the faces of all 

your family, friends and 

colleagues as you include 

them in snapshots and movies 

on your computer, using 

Connectix QuickCam and its 

associated software. 

A great offer 
for members 

QuickCam with attachments and associat¬ 

ed software normally retails for $279 but 

Communique members can receive a 20% 

discount, paying only $223. Offer valid 

until May 31, 1996. 

For more information, contact 

Firmware Design on (047) 21 7211, 

or fax them on (047) 21 7215. 

Tech 
Info 

Connectix QuickCam’s 

fully digital operation offers 

higher quality at a lower 

cost than solutions that 

have to convert signals 

from analog to digital. 

QuickCam captures 

video and still images in up 

to 64 shades of grey at 

sizes up to 320 by 240 pix¬ 

els. It has the equivalent of 

a wide angle lens and its 

frame rates are up to 18 

per second for a 160 by 

120 pixel image. 

QuickCam requires at 

least a 386 PC with a mini¬ 

mum of 4Mb of memory 

and at least I Mb of hard 

disk space (more to store 

movies). 



Our connections give you 

more benefits 

Throw those ugly plastic dust covers 

away and get the coolest computer 

accessory yet - one that’s 100% cotton! 

Rhuma Designs is an Australian 

company that makes the grooviest and 

most functional covers to keep the dust 

out of your monitor and your keyboard 

clean. There’s a choice of plain colours 

(navy, light blue, green, burgundy and 

taupe), patterns and four popular screen print designs. So when your 

computer isn’t in use you can dress it up and keep it clean! 

Rhuma Designs will also screen print motifs of your choice, or print 

your company logo on cover sets. 

Communique members will receive a discount of 20% on the range 

of cover sets, which come in two sizes. Standard size (for 14-15 inch 

monitors) in plain normally costs $31.50 (members’ price only $25.20); 

with screen printing $35.50 (members’ price only $28.40). Large size (for 

up to 20 inch monitors) in plain normally costs $36.50 (members’ price 

only $29.20); with screen printing $40.50 (members’ price only $32.40). 

Offer valid until June 30,1996. ■ For more information contact Rhuma Designs on (02) 9913 9373, 
or fax them on (02) 9997 3919. 

1 
Even Better Cheques 
and Balances 

jl. Free Sample Packs of handy 

cheques for use with Microsoft 

^ Money are now available and 

members who then purchase will receive a bonus 

as well. So if you’re still hand writing your 

cheques and manually arjjusting your records, 

you can save time, and automatically and accurately keep on top of your 

budget balance by using the cheques packs from Forms Express. 

These Small Business Cheque Packs are computerised cheque station¬ 

ery. Using this stationery with Microsoft Money, your cheques will automat¬ 

ically be printed out in accordance with bank specifications and your 

records automatically kept up to date. Home and small business manage¬ 

ment is made easier and all that’s left to do is provide a signature. 

Communique members ordering any of these cheque packs will receive 

20 per cent extra free. Choose from continuous cheques, continuous 

cheques with remittance, laser cheques and laser cheques with remittance. 

These cheques are available in quantities of250 (for just $69), 500 or 1000. 

Offer valid until June 14,1996. 

A quick-fix for many 
scourges 

'k When spasms 

paralyse the 

smooth flow of 

your computing, and con¬ 

fusing and cryptic error 

messages accompany 

them, the problem-solver 

First Aid 95 can come to 

the rescue. 

Most malfunctions will not be the fault of Win¬ 

dows 95 itself but rather result from the interaction 

of dozens of applications and drivers for sound 

cards, CD-ROM drives, printers and other hardware 

add-ons. Whether it be applications failing to launch, 

the printer not responding, the modem freezing on 

the spot or files vanishing, First Aid 95 has a knowl¬ 

edge base that can detect and fix more than 1000 of 

these common configuration problems as soon as 

they arise. Much like a virus checker, First Aid 95 

sits silently in the background and doesn’t interrupt 

normal operations. 

The product is described as designed to help 

technical support staff within larger organisations 

resolve problems faster as well as assist the comput¬ 

er novice when some inexplicable mishap has 

stalled proceedings. 

Normally retailing for $99, Communique mem¬ 

bers are offered First Aid 95 at the 20% discount 

price of $79 (plus postage and handling). Offer valid 

until May 31,1996. 

First Aid 95 

I For further informat'n 
on (02) 888 1955, or 1 

: Software Suppliers 
n (02) 888 7965. 

more information contact Forms Express < 
ise the free fax number for both enquiries 

1-800 808 862 
i ordering: 1-800 676 641. 
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COMMUNIQUE 

Are you using the latest 
and best version of your 

software? 
Word is... 

ready to perform 
Microsoft Word for Windows 95 

2^ More innovative than the first bottle of ‘white out’ and 
• more intuitive than ever, Microsoft Word for Windows 95 

revolutionises the way you process words in your imagination. 
Anyone who has to prepare documents as part of their job or 

business knows how necessary it is to have a word processor 
they can rely on, and one that fits in with the way you do things. 
Word for Windows 95 is the same dependable word processor as 

its predecessors with some very important exceptions, including 
automatic spelling check (which identifies incorrect spelling with 

a wavy red underline) which lets you select possible spellings at a 
mere right click! 

Word for Windows 95 also has super smart AutoCorrect func¬ 
tions which means things like accidentally typing two uppercase 

letters in the one word 

will be automatically fixed for you. Creating numbered or bullet¬ 

ed list is also a lot easier, just tab and use an asterisk once and 
Word takes over! 

You’ll never be lost for a way of creating the look and feel you 

want for your documents as Word also comes with a whole stack 
of templates and Wizards to help you get going. 

The latest version of Word supports all the features of Win¬ 
dows 95 from the long file names to complete seamless integra¬ 
tion with the other applications of the Microsoft Office suite and 

increased compatibility with other word processors, so moving 
across is hassle-free. 

Communique members can upgrade to Word for Win- 

dows 95 for $149. Non-members can upgrade for $169. 

WINDOWS 95 *art number relate to 3.5" disks unless otherwise shown as: • CD-ROM S EVe U p to $50 
Product Platform Number WrsTon 

Upgrade Communique 
Price 

Microsoft Windows 95 Win 95 050-031-950A 
050-052-950A • 

Any version of Windows 3.x $159 $139 

Microsoft Access for Windows 95 
(CCP)-6 

Win 95 077-054-004A Any version of Access for Windows $169 $149 

Microsoft Access Developer’s 
Toolkit for Windows 95 

Win 95 077-754-700A 
077-756-700A • 

Any previous version Access Developer’s Toolkit $599 $549 

Microsoft Cinemania 96 Win 95 194-056-096A • 1992 or later $39 $29 

Microsoft Excel for Windows 95 
(CCP)2 

Win 95 065-054-701A Any version of Excel for Windows $169 $149 

Microsoft Money for Windows 95 Win 95 105-054-400Z 
105-056-400Z • 

Any version of Money for Windows $I54 $I54 

Microsoft Office Value Pack Win 95 528-00023 • Any version of Office for Windows, 
or one of its applications, or qualifying 
competitive products. 

$599“ $549“ 

Microsoft Office for Windows 95 
Professional Edition (CCP)-7 

Win 95 
Win 95 

269-054-70IZ 
269-056-70IZ • 

Any version of Office for Windows 
or one of its applications 

$499 $449 

Microsoft Office for Windows 95 
Standard Edition (CCP)~7 

Win 95 
Win 95 

021-054-70 IZ 
021-056-70IZ • 

Any version of Office for Windows 
or one of its applications 

$399 $349 

Microsoft PowerPoint 
for Windows 95 (CCP)-' 

Win 95 079-054-701A Any version of PowerPoint for Windows $169 $149 

Microsoft Project for Windows 95 
(CCP)~5 

Win 95 076-054-701A Any version of Project for Windows or MS-DOS $229 $199 

Microsoft Publisher 
for Windows 95 (CCP) 9 

Win 95 164-054-30 IZ 
164-056-30IZ • 

Any version of Publisher for Windows $894 $794 

Microsoft Schedule-t 
for Windows 95 

Win 95 06I-054-700A Schedule+ 1.0 for Windows $99 $79 

Microsoft Word for Windows 95 
(CCP)' 

Win 95 059-054-70 IZ Any version of Word for Windows or MS-DOS $169 $149 

Microsoft Works for Windows 95 
(CCP)-5 

Win 95 070-054-425AA Any version of Works for Windows or MS-DOS $694 $594 

Microsoft Works for Windows 95 
& Bookshelf 95 (CCP) 5 

Win 95 070-056-425AA Any version of Works for Windows or MS-DOS $99' $794 



Order Form ^or ^croso^ Upgrade Products, 
Membership Subscriptions & Renewals 

Please PRINT your NAME AND ADDRESS details: 

Mr □ Mrs □ Ms □ Miss □ Other_Surname_ 

Given Name_Company (if applicable)_ 

Position_Street Address _ 

Suburb_State_Postcode_ 

Daytime Phone ( )_Evening Phone ( )_Fax ( ) _El-mail _ 

My COMMUNIQUE NUMBER is | | [ | | | | ~| Please leave out the zeros at the front of your membership number. 

□ Please indicate if the above is a new address. 

To ORDER Microsoft UPGRADE PRODUCTS: 
If you need help filling in the following details, please refer to the upgrade information tables at the back of your magazine. Be sure to check the product 
number is correct and the price you’re quoting is taken from the ‘Communigue price’ column. 

Product Media Part No. Price Quantity* Sub Total 

□ 3.5- DISK 
□ CD-ROM 
□ 3.5' DISK 
□ CD-ROM 
□ 3.5' DISK 
□ CD-ROM 

If you would like to order more than 3 upgrades please make a photocopy of this form. 
★ Only Communique members placing orders valued at more than $100 are exempt from postage & handling. 
* An individual Communique member is only entitled to upgrade one copy of each application installed on his/her computer at the discount price. 

My SIGNATURE verifies that I own a previous version of the 

produces) which I am upgrading. Please note, only members or 

renewing members are not required to return original diskettes. 

Postage & Handling 

$9.95* 

Total Upgrades 

$ 

Membership SUBSCRIPTONS: 

I wish to join: 

□ Communique for 2 years @ $90 

□ Communique for 1 year @ $49, 

□ Communique Care for 1 year @ $99, $_ 

OR: 

Membership RENEWALS: 

I wish to renew my Communique membership: 

□ Communique for 2 years @ $90, □ Communique for 1 year @ $49, □ Communique Care for 1 year @ $99, $ 

OR: 

Membership UPGRADES: 

□ I wish to upgrade my current $40 membership to Communique Care; my $59 payment is enclosed. $ 

AND: 

COMMUNIQUE POWERBASE CD-ROM: 

□ I wish to purchase Communique PowerBase CD-ROM @ $30 plus $9.95 handling and postage; 

my $39.95 payment is enclosed. $ 

PAYMENT Details: 
I would like to pay by □ Bankcard □ Visa 

□ Diners Club □ Cheque 

Credit Card Number: 

Cardholder’s Name:_Cardholder’s Signature:_ 

Please SEND, FAX or CALL your ORDER through to: 

Reply Paid 263, Microsoft Pty Ltd, PO Box 200 North Ryde NSW 2113 (no stamp required) 

Ph: (02) 870 2111, or 1-800 257 253 (if you’re outside Sydney). Fax: (02) 870 2285 

Please allow 4 weeks for delivery of your order and/or your Communique membership card. Membership available in Australia only. 

THANK YOU FOR YOUR ORDER 

□ Mastercard 

□ Money Order 

Expiry Date:_/_ 

CB0596 



COMMUNIQUE 
Tips&Techmques 

is Microsoft’s customer program. It offers valuable 

time-savers, information, discounts and help to make your life 

easier and assist you in getting more out of 

computing - it’s our way of making sure you 

get the best that Microsoft has to offer. 

TIMESAVERS 
Six issues every year of the Tips & Techniques supplement for either 
Windows or Macintosh. This free publication is crammed with hints, 
short cuts, tutorials and program information to help you get more 
out of your software. 

Free use of the HotFax service to get up-to-date information on all 
Microsoft products - exclusive to Communique members. 

Access to Communique Technical News (CTN) via HotFax. Compiled 
at our Seattle headquarters to bring you the latest and hottest news 
and tips from developers and other techo experts. 

Free access to Microsoft Connect - our bulletin board which you 
access via a modem for self-help on all Microsoft products. 

A special member price of $30 (plus postage & handling), instead 
of $45, for the new Communique PowerBase CD-ROM, a self help 
reference full of technical tips. 

Microsoft TechNet is a reference guide designed for technical 
professionals and it’s the leading resource for fast, complete answers 
to the toughest problems on the Microsoft desktop and system 
products. As a Communique member your year’s TechNet subscription is 
only $395, (plus postage & handling) - or you can buy a single issue of 
TechNet for $40 (plus postage & handling) instead of the normal non 
member price of $60. 

The Microsoft Developer Network (MSDN), a membership 
program for the serious software developer or corporate 
development group: 

Level I entitles you to a quarterly Development Library on 
CD-ROM plus bi-monthly Developer Network News. Communique 
members pay only $395 (plus postage & handling) - a saving of 10%. 

Level 2 offers members all the benefits of Level 1 plus the latest 
releases of Microsoft Software Development Kits and Device 
Driver Kits. Communique members pay only $765 (plus postage 
& handling) - a saving of 15%. 

The new Level 3 delivers all the above plus the BackOffice Test 
Platform - a set of CD-ROMS providing BackOffice Server for 
testing and developing purposes. Communique members pay only 
$1,695 (plus postage & handling) instead of $1,795. 

If you want to read articles with a more technical bent than the 
magazine’s, Communique On-Line is for you. Log on and discover 
more complex hints and tips, as well as a forum to debate the 
technological issues of the moment. 

A DISCOUNTS 
Keep up to date with the latest software and receive exclusive 
discounts (up to $50) on Microsoft upgrades. 
Master your software with a 20% discount on training from Drake, 
Citidata, Citisoft and ACCS. 

Use Microsoft connections to receive exclusive discounts on other 
products such as hardware and software that complement our own. 
Offers are announced every month in Communique magazine. 
Receive an exclusive $ 100 discount on a subscription to Microsoft 
TechNet - an invaluable reference guide for technical professionals. 

Communique members enjoy exclusive discounts (up to 15%) on all 
three levels of the MSDN membership program. 

wHELP 

> INFORMATION 
I I great monthly issues of Communique magazine (including 
the bumper holiday issue) with 56 pages packed with hints, 
features, news, interviews, letters, tips and user stories. 

Communique magazine binders protect Communique copies 
and Tips and Techniques. Easy access to your information. 
Binders cost only $15 each plus postage and handling. 

Self-help with 10% off all Microsoft Press® books at Dymocks, 
Uni Co-Op book shops and selected book resellers. 

Communique members can call an exclusive 1-800 toll free number 
for help with your software problems. 

Standard Support comes free. It’s what you ask for if you’ve 
registered your software and you’re having problems installing - 
or you think you’ve encountered a product bug. 

Priority Support is what we’ll ask you to pay for but relax because 
Communique membership entitles you to great savings. Just get on 
the phone and get talking. We’ll try to solve your problem before 
putting down the receiver. 

Choose the support payment option of your choice; 

Support as you need it If you’re a Communique member you 
can buy Desktop Support at $25 per problem solved instead of 
the normal $35 for non-members. 

The convenience of pre-bought support If you’re using 
Desktop Support fairly regularly, save time and money by getting 
a Pack of 6 Support Calls. Communique members are entitled to 
great savings, paying only $130 (instead of the usual $210) for a 
Pack of 6 and only $240 (instead of $420) for a Pack of 12. 
Communique Care offers all the benefits of standard 
Communique membership plus five priority support calls for $99. 

Professional Support All Communique members have access to 
Professional Support at $100 per problem solved, instead of the 
normal $145 for non-members. Communique Care offers even 
greater savings at $85 per problem solved. 

Plus, your personalised membership card identifies you as a 
member of Microsoft Communique, and gives you access to your 
exclusive Communique benefits. 

For more information on the Communique Program and 
benefits cad 1-800 817 328 or in Sydney call (02) 870 21 11. 



APPLICATIONS •art numbers relate to 3.5” disks unless otherwise shown as: CD-ROM S 3.V 6 U p to $50 

Product Platform Part b 
V™o„ Pr^ade 

Communique 

Microsoft Access 2.0 (CCP)~6 Windows 077-051-208A Access 1.0 or l.l $169 $149 

Microsoft Access Developers 
Toolkit 2.0 

Windows 077-751-200A Access Distribution Kit l.l $499 $449 

Microsoft Bookshelf 1996-97 Windows 
Macintosh 

086-052-023 • 
TBA • 

1991,92, 93,94, 95 $59 $49 

Microsoft Creative Writer l.l 
disk to CD-ROM conversion 

Windows 
Macintosh 

265-056-I00Z • Creative Writer for Windows or Macintosh 
version 1.0 

$25 $25 

Microsoft Encarta 95 Macintosh 196-088-003A • 1992 or later $79 $69 

Microsoft Encarta 96 Windows 196-056-010A • 1992 or later $59 $49 

Microsoft Excel 5.0 (CCP)~7 Windows 
Macintosh 

065-I5I-500A 
065-096-688A 

1.0-4.0 $169 $149 

Microsoft Fine Artist l.l 
disk to CD-ROM conversion 

Windows 
Macintosh 

266-056-I00Z • Fine Artist for Windows or Macintosh 
version 1.0 

$25 $25 

Microsoft FoxPro 2.6 
Standard Edition 

MS-DOS 215-895-020 FoxPro 2.5 $49 $49 

Microsoft FoxPro 2.6 
Professional Edition 

MS-DOS 
Macintosh 

2151095-260A 
2151096-260A 

Any Standard Edition of FoxPro $499 $499 

Microsoft FoxPro 2.5 Professional 
to 2.6 Professional for Macintosh 

Macintosh 2151096-020 FoxPro for Macintosh Professional 2.5 $79 $69 

Microsoft FoxPro 2.5 to 2.6 
Distribution Kit upgrade 

MS-DOS 215-695-020 FoxPro Distribution Kit 2.5 $49 $49 

Save up to $50 on upgrades 
APPLICATIONS Part numbers relate to 3.5" disks unless otherwise shown as: CD-ROM S 3 V & Up to $50 

Product Platform Number Version PrkeadC 
Communique 

Microsoft Mail 3.5 for 
PC Networks Server 

Windows 068-695ZV350 MS Mail Server version 2.1 - 3.2, Workgroup Post 
Office Upgrade (from WFW 3.x, Windows NT 3.x, 
and Windows 95), or a Competitive Server. 

$499 $449 

Microsoft Money 3.0 Windows 105-051-300AA 1.0-2.0 $19 $19 

Microsoft Mouse 
Intellipoint l.l Driver 

Windows 135-099-389 1.0- 10.0 $14.75 $14.75 

Microsoft Access 2.0 upgrade 
for Office for Windows (CCP)~7 

Windows 077-051-208A Office for Windows 4.2 Standard Edition $169 $149 

Microsoft Office 4.2 (CCP)'7 Windows 

Macintosh 

02I-05I-462AAHO 
02I-05I-463AAH) 
021-096-425AA 

Office 1.0 - 3.0, Word, Excel, PowerPoint or 
Access (see -a), or any version of Works (~b) 

$399 $349 

Microsoft Office Professional 4.3 
for Windows (CCP)'7 

Windows 269-05I-436AAH0 
269-05 l-437AAH>> 

Office 1.0 - 3.0, Word, Excel, PowerPoint or 
Access (see -a), or any version of Works (~b) 

$499 $449 

Microsoft PowerPoint 4.0 (CCP)-4 Windows 
Macintosh 

079-051-427A 
079-096-405A 

2.0 - 3.0 $169 $149 

Microsoft Project 4.0 (CCP) 5 Windows 
Macintosh 

076-051-I20A 
076-096-040A 

1.0-3.0 $229 $199 

Microsoft Publisher 2.0 Windows 164-051-200Z 1.x $89 $79 

Microsoft Publisher for Windows 
Licence Pack" 

Windows 1644050-200AMLP 1.x $109 $89 

Microsoft SQL Server 6.0 
forWindows NT 

Win NT 228-075-600A • 1.x or 4.x $739 $689 

Microsoft SQL Workstation 6.0 
forWindows NT 

Win NT 228-875-600A • 1.x or 4.x $369 $319 



COMMUNIQUE 

APPLICATIONS Part number relate to 3.5" disks unless otherwise shown as: CD-ROM Save UD to $50 
Product Piatform Part 

Number 
From 
Version 

Upgrade Communique 

Microsoft Visual FoxPro 3.0 
Standard Edition 

Windows 215-051 -130A 
215-052-130A • 

FoxPro Standard 2.x $159 $139 

Microsoft Visual FoxPro 3.0 
Professional Edition 

Windows 2151051 -130A 
2151052-130A • 

Any version of FoxPro 2.x $449 $399 

Microsoft Windows NT 
Workstation 3.51 

Win. NT 
Win. NT 

236-074-570A 
236-074-351A 

Windows NT version 3.5 
Windows NT version 3.1 

$79 
$159 

$69 
$139 

Microsoft Word 6.0 for MS-DOS Windows 034-095-600AA Word 1.0-5.5 for MS-DOS $169 $149 

Microsoft Word 6.0 (CCP)'1 Windows 
Macintosh 

059-151-112AA 
034-196-I09AA 

Word 1.0 - 2.0 for Windows, 1.0 - 6.0 for MS-DOS 
Word 1.0 - 5.1 for Macintosh 

$169 $149 

Microsoft Works 3.0 (CCP)'3 Windows 070-051-303AA 
070-052-300A • 

Works for MS-DOS 1.0 - 3.0 
Works for Windows 2.0 

$69 $49 

Microsoft Works 4.0 
for Macintosh (CCP) 3 

Macintosh 070-096-400AA Works for Mac 1.0 - 3.0 $69 $49 

Microsoft Works 4.0 
& Bookshelf 95 

Macintosh 070I-088-400Z Works for Mac 1.0 - 3.0 $99 $79 

Microsoft Works 
Licence Pack" 

X-platform 0704055-400AMLP Works for MS-DOS 1.0-3.0, 
Works for Windows 2.0 
Works for Mac 1.0-3.0, 

$59 $49 

Microsoft Works 3.0 for MS-DOS MS-DOS 070-295-300Z 1.0-2.0 for MS-DOS $69 $49 

PRICES SUBJECT TO CHANGE WITHOUT NOTICE 
★ On products listed in the Communique upgrade pages. 
* Includes Excel 5.0, PowerPoint 4.0 and a copy of Word 6.0 for Windows. 

1 Compliance checking: requires previous version of Word. 
3 Compliance checking: requires previous version of Works. 

'5 Compliance checking: requires previous version of Project. 
7 Compliance checking: requires any version of an Office application. 

Compliance checking: requires previous version of Publisher. 

■' Offer valid until March 31, 1996 
** Licence Packs do not contain disks or documentation. 
~2 Compliance checking: requires previous version of Excel. 

Compliance checking: requires previous version of PowerPoint. 
• Compliance checking: requires previous version of Access. 
8 Compliance checking: requires an equivalent competitive product. 

*** Limited offer. 

LANGUAGES *art numbers relate to 3.5" disks unless otherwise shown as: CD-ROM SclVG U D to $50 
Product Part b 

Version 
Upgrede Communique 

Fortran 5.1 005-045-510A 1.0 $119 $99 

Fortran Powerstation 4.0 
Standard Edition 

250-056-325A Any Fortran $449 $399 

Fortran Powerstation 4.0 
Professional Edition 

250I056-325A Any Fortran $739 $689 

Macro Assembler 6.1 016-051-61IA 1.0 $129 $109 

Visual Basic 1.0 for MS-DOS 
Professional Edition 

203-095-I00A Quick Basic 1 .x, Basic PDS 1 ,x-7.1 $299 $269 

Visual Basic 1.0 for MS-DOS 
Standard Edition 

046-095-I00A Quick Basic 1 .x, Basic PDS 1 .x-7.1 $159 $139 

Visual Basic 4.0 for Windows 95 
& Windows NT Std Edition 

046-051-400A Visual Basic for Windows 2.0, 3.0 Standard Edition $89 $79 

Visual Basic 4.0 for Windows 95 
& Windows NT Pro Edition 

203-054-205A 
203-056-205A • 

Visual Basic for Windows 2.0, 3.0 Professional Edition $149 $129 

203-054-205A 
203-056-205A • 

Visual Basic for Windows 2.0, 3.0, 4.0 Standard Edition $449 $419 

Visual Basic 4.0 for Windows 95 & 
Windows NT Enterprise Edition 

2031056-400A • Visual Basic for Windows 3.0, 4.0 Professional Edition $739 $689 

Visual C++ 4.0 Subscription 0482056-060A • Microsoft Visual C++ 1.x, 2.x $519 $469 

Visual C++ 4.0 0482156-060A • Any C/C++ Compiler $379 $329 

Visual Test 163-056-400A Test 1.0-3.0 $299 $269 

Visual SourceSafe 324-056-110A SourceSafe I.0-3.X or Delta 1.0 $159 $139 



Are you using the latest 
and best version of your 

software? A grab pack 
of goodies 

Microsoft Office Value Pack 

Upgrade and get everything you need to put you and 

your business on the fast track with all the hot software 

and extras that make up the Microsoft Office Value Pack. 

The Microsoft Office Value Pack allows you to upgrade all 

your favourite applications at once! For starters the pack con¬ 

tains the complete suite of Windows 95 applications that make 

up Microsoft Office Professional, including Word, Excel, Access, 

PowerPoint and Schedule-i-. As well there’s the CD deluxe ver¬ 

sion of Microsoft Publisher, which allows you to create newslet¬ 

ters, brochures, flyers and heaps more! 

This whopping big package also includes Microsoft’s answer 

for small business users - the Small Business Pack - with tools 

for planning and keeping track, and the Windows 95 training CD- 

ROM which will 

introduce new users of the 

platform to all the handy bits and bobs that make life easier. 

When you’ve mastered the new look Windows there’s 

Microsoft Plus! You can use Plus! to add some great touches to 

your machine, sort out your Internet connection and give you 

some great system tools. 

The Microsoft Office Value Pack also comes with the 

Microsoft Ergonomic Mouse, a great third-party add-in business 

graphics program and three CD samplers of other products in 

the Microsoft Home range - and games! 

Communique members can upgrade with the Microsoft 

Office Value Pack for $549. Non-members can 

upgrade for $599. 

Swap and Save up to $50 
product thanks to our competitive Trade-Ups. Simply find if your current product qualifies to be traded up and note the 

Then fill in the upgrade order form and send it with all of your original disks from your current product. It’s so very easy 

can 

Microsoft 

Drice. 

Product Platform Number 
Upgmde c_iqu, 

Microsoft Excel 5.0 Macintosh 065-096-690A Upgrade from any competitive spreadsheet 
with an RRP greater than $400. 

$169 $149 

Microsoft Office 4.2 Macintosh 021-096-420AA Upgrade from any competitive word-processing, 
business graphics, spreadsheet package with an RRP 
greater than $400, or any version of ClarisWorks. 

$399 $349 

Microsoft PowerPoint 4.0 Macintosh 079-096-400A Upgrade from any business graphics package 
with RRP greater than $400. 

$169 $149 

Microsoft Project 4.0 Macintosh 076-096-400A Upgrade from any competitive project management 
package with an RRP greater than $400. 

$229 $199 

Microsoft Publisher 2.0 Windows 164-051-200Z Upgrade from any competitive desktop publishing 
package with an RRP greater than $ 100. 

$89 $79 

Microsoft Word 6.0 Macintosh 
MS-DOS 

034-196-110AA 
034-095-600AA 

Upgrade from any competitive word-processing 
package with an RRP greater than $400. 

$169 $149 

Microsoft Works 4.0 Macintosh 070-096-400AA Upgrade from any competitive Macintosh integrated 
package with an RRP greater than $100. 

$69 $59 

Microsoft Access (CCP)-8 Win 95 077-054-004A Upgrade from any database package. $I694 $149 

Microsoft Excel (CCP)~8 Win 95 065-054-701A Upgrade from any spreadsheet package. $I694 $149 

Microsoft Office 
Professional Edition (CCP)8 

Win 95 269-054-70IZ 
269-056-70IZ • 

Upgrade from any spreadsheet, word-processor, 
database or business graphics package. 

$4994 $449 

Microsoft Office 
Standard Edition (CCP)8 

Win 95 021-054-70 IZ 
021-056-70 IZ* 

Upgrade from any spreadsheet, word-processor, 
database or business graphics package. 

$399* $349 

Microsoft PowerPoint (CCP)~8 Win 95 079-054-701A Upgrade from any business graphics package. $I694 $149 

Microsoft Word (CCP)8 Win 95 059-054-70 IZ Upgrade from any word-processing package. $I694 $149 

Microsoft Works (CCP)-8 Win 95 070-054-425AA Upgrade from any intergrated package. $69 $49 



COMMUNIQUE 

DIRECTORY 

MICROSOFT 
SERVICES SALES 
INFORMATION 

CENTRE 

The following numbers are for 

Communique members only. 

Others can call (02) 870 2100. 

9.00am - 5.00pm (EST) 

Call (02) 870 2111 

Or for those outside 

Sydney 1-800 257 253 

The Sales Information Centre 

provides pre-sales product 

information, upgrade order 

services, and answers 

Communique enquiries and 

general enquiries. 

PRODUCT SUPPORT 

Product Support Services 

provides post-sales technical help 

in two categories. Please have 

your Communique number and 

PIN ready when you call. 

STANDARD SUPPORT 

-NO CHARGE 

8.00am - 8.00pm 

Monday - Friday (EST) 

Call (02) 870 2113 

(Sydney area) 

or 1-800 817 328 

(outside Sydney) 

If you have trouble installing 

Microsoft software (this does not 

apply to Business Systems prod¬ 

ucts), or if you believe you’ve 

encountered a fault, then Standard 

Support is what you need. As a 

Communique member, you get 

direct access to our Support 

Analysts, who will do their best to 

solve your problem. This service 

is free of charge (except for the 

cost of the call). 

The info on these pages 
changes each month. If you 
can’t find something please 
check your back issues. 

PRIORITY SUPPORT 

8.00am - 8.00pm 

Monday - Friday (EST) 

Call (02) 870 2133 

(Sydney area) 

or 1-800 808 532 

(outside Sydney) 

If you would like assistance with 

how to use specific features of 

Microsoft software, then Priority 

Support can help. As a 

Communique member, you get 

priority access to our Support 

Analysts, who will do their best to 

assist you. This service is charge¬ 

able. Rates vary according to your 

Communique membership level 

and the category of the product 

for which you want help (see the 

description of Desktop and 

Professional products categories 

below). You must possess a valid 

Priority Support contract before a 

Support Analyst can handle your 

problem. 

DESKTOP & PROFES¬ 

SIONAL SUPPORT 

Which support is right for you? 

Microsoft products attract 

different support charges depend¬ 

ing on their category. 

The Desktop category includes 

all applications, non-server operat¬ 

ing systems, and hardware - 

products typically used by individu¬ 

als for their own purposes. 

Desktop products include Word, 

Excel, Office, PowerPoint, 

Publisher, Project, Access, all Mail 

client products, all Home products 

(including Works, Money, Kids, 

Flight Simulator, all Multimedia 

titles, and all games), Windows, 

Windows for Workgroups, MS- 

DOS, the non-server components 

of all versions of Windows NT, 

and all hardware products (includ¬ 

ing the Microsoft Mouse and 

Windows Sound System). 

The Professional category 

includes all software development 

tools, networking, and systems 

products - products typically used 

by application developers and/or 

computing professionals to create 

software solutions. Professional 

products include all programming 

languages, all Microsoft SDKs and 

APIs, all other development tools 

(including Delta and the Microsoft 

Source Profiler), all Fox products 

(including FoxPro and FoxBase), 

SQL Server, Lan Manager, all non¬ 

client Messaging products, all 

Gateways, and the server compo¬ 

nents of Windows NT Advanced 

Server/Windows NT Server. 

CONNECT 

BULLETIN BOARD 

Call 24 hours, 7 days a 

week (02) 878 5200. 

Microsoft’s self-help bulletin 

board, covers the range of 

Microsoft Desktop and 

Professional products, and lets you 

browse at leisure and download 

over a modem the information 

you need as you need it. This 

service is free of charge (except 

for the cost of the call). 

MICROSOFT 
TECHNET 

Microsoft TechNet is designed 

for technical professionals who 

support and train users, adminis¬ 

ter databases or networks, 

integrate products and platforms, 

or evaluate and specify new 

products and solutions. Microsoft 

TechNet is the leading resource 

for fast, complete answers to 

technical questions on Microsoft 

desktop and system products. 

Updated monthly on CD-ROM, it 

provides the most complete 

collection of technical information 

on Microsoft products anywhere. 

Special subscription discounts are 

available to Communique Care 

and Communique Pro members. 

For more details phone: 

(02)870 2111 or 1-800 257 253 

outside Sydney. 

TRAINING 

Microsoft Institute of 

Advanced Software 

Technology 

Hands-on technical courses to 

help programmers take full 

advantage of the latest Microsoft 

systems software. 

9.00am - 5.00pm EST. Telephone 

(02) 870 2250 or fax (02) 870 2255. 

Microsoft Solution 

Providers Authorized 

Technical Education 

Centers 

4- Alpha West Pty Ltd - Perth (09) 

481 4140 ♦ Aspect Computing - 

Sydney (02) 9928 1188 Melbourne 

(03) 9818 0604 Adelaide (08) 379 

0466 Canberra (06) 247 7608 

♦ Auldhouse Computer Services - 

Chatswood (02) 415 3955 

Melbourne (03) 9804 5648 Brisbane 

(07) 3221 2105 ♦ Citidata - Sydney 

(02) 9906 1935 ♦ Com Tech Com¬ 

munications Pty Ltd - Sydney (02) 

317 3088 Melbourne (03) 9696 0770 

Brisbane (07) 3221 2444 Perth (09) 

322 5605 Adelaide (08) 271 8600 

Canberra (06) 257 7695 ♦ Dialog 

Pty Ltd - Brisbane (07) 3368 2011 

♦ Educom - Melbourne (03) 9670 

0388 Sydney (02) 9957 1633 

♦ Global Knowledge Network - 

Sydney 1-800 647 468 Melbourne 

(03) 9275 3333 ♦ Imageword - 

Adelaide (08) 361 8533 Brisbane (07) 

3854 1149 Canberra (06) 257 5045 

Perth (09) 481 8820 ♦ InfoMat - 

Melbourne (03) 9888 6399 ♦ The 

Training Group of Newcastle - 

Newcasde (049) 672 777 ♦ The 

Quill Consultancy - Hobart (002) 

238 277 



DIRECTORY 

Microsoft Authorized 

Apple Macintosh 

Training Centers 

♦ Apple Centre - Alice Springs 

(089) 529 300 Apple Centre - 

Darwin (089) 430 649 ♦ Random 

Access WA - Perth (09) 278 1000 

♦ Choice Systems - North Sydney 

(02) 9957 4314 ♦ CPM&S Group - 

Norwood (08) 362 4949 ♦ Forrest 

Training - Sydney (02) 262 2284 

♦ Logical Solutions Training Centre 

- Sydney (02) 367 8505 Deakin (06) 

283 3244 South Melbourne (03) 

9696 5608 Spring Hill (07) 3832 

3999 ♦ The Quill Consultancy - 

Hobart (002) 238 277 ♦ The 

Training Group NSW - Waratah 

(049) 672 777 

Microsoft Solution 

Providers Authorized 

Training Centers 

ACT - ♦ Citidata - Deakin (06) 

285 3902 4 Drake Training - 

Canberra (06) 249 7366 ♦ Fern- 

tree Computers - Canberra (06) 

248 8488 4 ImageWord - Campbell 

(06) 257 5045 ♦ MTE - Canberra 

(06) 247 6333 4 Wizard Computer 

Training - Canberra (06) 275 0730 

NSW - ♦ ACCS Australian Centre 

for Computer Science - North 

Sydney (02) 9957 4244 4 Applied 

Functional Training - St Leonards 

(02)9906 3773 4 Aspect 

Computing - North Sydney 

(02) 9957 3188 ♦ Bolstler Fahey - 

Sydney (02) 264 2203 4 Citidata - 

St Leonards (02) 9906 1935 

♦ Drake Training - Sydney (02) 

262 3900 North Sydney (02) 

9957 5888 Parramatta (02) 891 1022 

Newcasde (049) 29 4755 ♦ Educom 

- North Sydney (02) 9957 5833 

♦ Femtree Computers - Sydney (02) 

9931 1600 4 Forrest Training - 

Sydney (02) 262 2284 ♦ ICOM 

Solutions - Sydney (02) 261 2499 

Parramatta (02) 891 4277 

♦ Integrated Business - Sydney (02) 

233 4000 Caringbah (02) 526 2455 

♦ InTouch Consultancy - Campbell- 

town (046) 250 986 ♦ MTE - 

Sydney (02) 261 5555 Parramatta 

(02) 891 3344 ♦ Network Logic - 

Sydney (02) 233 7500 ♦ Poliak 

Partners - Sydney 1-800 227 440 

Parramatta (02) 687 1977 ♦ The 

Training Group - Newcastle (049) 

67 2777 4 Training and Support- 

North Sydney (02) 9956 6366 

Parramatta (02) 893 9000 

SA - ♦ Aspect Computing - 

Adelaide (08) 379 0466 ♦ CitiSoft - 

Parkside (08) 373 5000 

♦ Computer Management Centre - 

Adelaide (08) 223 0600 ♦ CPM&S 

Group - Norwood (08) 362 4949 

♦ Drake Training - Adelaide (08) 

212 2525 4 Ferntree Computers - 

Eastwood (08) 373 0454 4 MTE - 

Adelaide (08) 231 3048 4 Poliak 

Partners - Adelaide (08) 231 0662 

♦ Protech - Adelaide (08) 231 4066 

♦ The Learning Laboratory - Kent 

Town (08) 362 4211 

Qld - ♦ ACE Training - Brisbane 

(07) 3236 2434 ♦ Drake Training - 

Brisbane (07) 3229 3827 4 Ferntree 

Computers - Milton (07) 3236 1114 

♦ Insight Training - Spring Hill (07) 

3839 8244 4 MTE - Brisbane (07) 

3221 3611 ♦ Technisyst - Brisbane 

(07)3229 3150 

Vic - ♦ Business Resolutions - 

Melbourne (03) 9650 4644 

♦ Computelec Australia - Seaford 

(03) 9786 7177 ♦ Drake Training - 

Melbourne (03) 9245 0444 

♦ Educom - Melbourne (03) 9670 

0388 ♦ Ferntree Computers - 

Melbourne (03) 9622 8000 

♦ Franklin Collins - Melbourne (03) 

9600 1577 ♦ Infbmat Australia - 

Canterbury (03) 9888 6399 ♦ MTE 

Melbourne - (03) 9629 5811 ♦ Ong 

Training - Melbourne (03) 9529 

8522 ♦ Poliak Partners - Melbourne 

(03) 9629 2977 ♦ Reflex Computer 

Services - Hawthorn (03) 9810 4545 

♦ Technisearch Ltd - Melbourne 

(03)9660 5100 

WA - ♦ AlphaWest Pty Ltd - West 

Perth (09) 481 4140 ♦ Australian 

Training Institutes - West Perth (09) 

322 6150 ♦ Drake Training - Perth 

(09) 321 2600 ♦ Femtree 

Computers - West Perth (09) 322 

2730 ♦ MTE - Perth (09) 324 1142 

Tas - 4- NDA Computing - Hobart 

(002) 242 660 Launceston (003) 344 

910 4 The Quill Consultancy - 

Hobart (002) 238 277 

AUTHORISED 
SUPPORT CENTRES 

Microsoft Authorised Support 

Centres offer a range of support 

services, including on-site support, 

help desk services and mission- 

critical support for all phases of 

planning, implementing and 

maintaining a client-server system. 

4 AT&T Global Information 

Solutions 1-800 678 666 4 Digital 

Equipment Corporation - (02) 561 

5999 or outside Sydney 1-800-657 

542 4 Wang Australia - 13 2666 

MICROSOFT 
DEVELOPER 

NETWORK 

The Microsoft Developer 

Network is a membership pro¬ 

gram that delivers complete, up- 

to-date information on Microsoft 

development technology. The 

Development Library, a quarterly 

CD, is the official vehicle for all 

the technical information neces¬ 

sary to program for Windows. 

The Development Platform is 

Microsoft’s distribution mecha¬ 

nism for software development 

kits and device driver kits. 

Microsoft Developer Network 

Subscribers can have exclusive 

access to a support package for 

developer products at special 

discounts. Special discounts on 

membership are available to 

Communique Care and 

Communique Pro members. 

For more details phone: 

(02) 870 2111 or 1-800 257 253 

outside Sydney. 

MICROSOFT 
CONSULTING 

SERVICES 

MCS provides high-level 

information technology consulting 

services to large businesses and 

corporations. 

Chris Fagan MCS Practice 

Manager - Australia: 

Telephone (02) 870 2200 or fax 

(02) 805 1108. 

NSW - Hugh Jones MCS Branch 

Manager: 

Telephone (02) 870 2200 or fax 

(02) 805 1108. 

ACT - Maneesh Sarvia MCS 

Branch Manager: 

Telephone (06) 273 2292 or fax 

(06) 273 2298 

VIC - Chris Worth MCS Branch 

Manager: 

Telephone (03) 9286 3200 or fax 

(03) 9286 3232 

WA-Gerard O'Neill MCS 

Branch Manager: 

Telephone (09) 420 8400 or fax 

(09) 420 8420 

QLD - Peter Kincade MCS 

Branch Manager: 

Telephone (07) 3218 7000 or fax 

(07)3218 7099. 

SOLUTION 

PROVIDERS 

Microsoft Solution Providers 

are a network of highly skilled 

professionals who can implement 

and support the very latest tech¬ 

nology. Their staff have a reliable 

set of technical skills and specialise 

in the building of complex solu¬ 

tions to help organisations. 

ACT - 4 Aspect Computing 

(06) 247 7677 4 Attachmate 

Australia (06) 247 2144 

4 Australian Technology Resources 

(06) 251 1100 4 CP Consulting (06) 

283 6777 4 CSC Australia (06) 201 

8400 4 Ferntree Computer 

Corporation (06) 248 8488 

S3 



EMP-3000 Multi-media Projector EPSON 

Brighten your image and lighten your load. 
The image EPSON'S EMP-3000 projects is 

so bright and sharp, you would never 

guess it came from such a small, 

lightweight, portable unit. 

Epson's EMP-3000 Data/Video Projection 

System weights under 7.7 kgs, and is as 

easy to carry as a briefcase. It fits under 

an airplane seat with room to spare. And 

with brightness up to 250 lumens, it lets 

you deliver a boardroom-quality 

presentation anywhere. 

It has everything you need to run 

computer-based presentations from both 

Windows-based PC's and Macintosh. With 

the handy remote control unit, you can 

switch back and forth between video and 

computer inputs at any time. 

So take your show on the road with the 

EPSON EMP-3000, the lightest and 

brightest in its class. 

Lighter 

Easily portable at 7.7 kgs. Fits 

comfortably under a plane seat. It's 

exceptionally accommodating to all 

transportation means. As easy as 

carrying a briefcase. 

Brighter 

Crisp image up to 250 lumens. 

Projection distance: 4' to 41' feet. 

Image size: 21" to 300" diagonally for 

use in small or large environments. 

Enables you to give a professional- 

quality presentation anywhere. 

PC, Macintosh and video compatible 

Software and cables included for 

Windows'" and Macintosh® systems. 

Video input (for VCRs, camcorders, 

and laser discs) accepts NTSC, PAL, 

or SECAM signals, and internally 

switches automatically. 

Easy to control 

Convenient, back-lit remote control unit 

included. Built-in menu interface for 

quick adjustment of all projector set-up 

variables. 

Universal power supply 

Allows for convenient use in most 

countries with a simple plug adapter. 

Advanced Visuals 

NSW (02) 817-5455 
VIC (039)432-8180 

or 
1-800 640 479 



DIRECTORY 

♦ ImageWord (06) 257 5045 

♦ Ipex Information Technology 

Group (06) 209 8000 ♦ Logical 

Solutions (06) 283 3200 ♦ Praxa 

(06) 257 5666 ♦ Protech Australia 

(06) 285 1900 ♦ pTizan Computer 

Services (06) 255 2187 ♦ Select 

Computer Technology 

(06) 241 5633 ♦ Softlaw 

Corporation (06) 242 1982 

♦ The Software Group (Aust) 

(06) 282 7022 ♦ Unisys Australia 

(06) 274 3544 

NSW - ♦ Access I.T. Asia Pacific 

(02) 9954 3554 ♦ Aspect 

Computing (02) 9957 3188 ♦ AT&T 

Global Information Solutions 

(Australia) (02) 9964 8111 

♦ Attachmate Australia (02) 9975 

7188 ♦ Axiom Information Systems 

(02) 9957 6299 ♦ Business 

Computers of Australia Pty Ltd (02) 

9906 3611 ♦ Clear Technology Pty 

Limited (02) 310 3077 ♦ Corporate 

Computer Sales (Australia) (02) 417 

5555 ♦ Computerland Bankstown 

(02) 709 5366 ♦ Connections 

(TSIP) Pty Ltd (02) 552 3088 ♦ CP 

Consulting (02) 428 7111 ♦ Cray 

Communications (02) 9928 0000 

♦ Digital Equipment Corporation 

(Australia) (02) 561 5252 ♦ Eden 

Technology (02) 241 3122 

♦ Educom Australia (02) 9957 5833 

♦ Equus Consulting (02) 261 4567 

♦ Essentially Solutions (02) 667 

1755 ♦ Ferntree Computer Corp¬ 

oration (02) 9931 1600 ♦ Fusion 

Technology (02) 9955 7044 

♦ Future Technologies (02) 299 

1400 ♦ GEC Alsthom IT (02) 415 

0500 ♦ Intergraph Corporation 

(02) 888 9900 ♦ Ipex Information 

Technology Group (02) 209 6666 

♦ JNA Network Services (02) 417 

6177 ♦ Lanrex Consulting Services 

Pty Ltd (02) 416 1100 ♦ Metquip 

Systems (02) 805 0311 ♦ Network 

Systems Technology (02) 499 2900 

♦ NT Solutions (02) 212 3999 

♦ Peterborough Software (02) 9975 

7277 ♦ Platinum Software (Aust) 

(02) 9956 6166 ♦ PM2 Systems (02) 

9956 8222 ♦ PowerLAN 

Technologies (02) 418 3600 ♦ Praxa 

(02) 9957 5607 ♦ Senteq Informa¬ 

tion Systems (02) 391 0555 

♦ Siemens Nixdorf Information 

Systems (02) 430 2100 ♦ Simply 

International (02) 9959 4555 

♦ Sloane Duff & Associates (02) 

211 1477 ♦ Starcom Business 

Systems (02) 882 0000 ♦ State 

Computer Supplies (02) 9957 1115 

♦ Strategic Software International 

(02) 418 2900 ♦ Sysygy Computer 

Networks (02) 9911 7727 ♦ Tardis 

Pty Ltd (02) 807 1777 ♦ TR Hall & 

Associates (02) 264 5300 ♦ Unisys 

Australia (02) 931 6666 ♦ WANG 

Australia (02) 847 7100 

NT - ♦ Digital Equipment 

Corporation (089) 463 000 

QLD - ♦ Data #3 Business 

Systems (07) 3371 8088 ♦ Ferntree 

Computer Corporation (07) 3236 

1114 ♦ Ipex Information Technology 

Group (07) 3406 5800 ♦ Praxa (07) 

3369 8100 ♦ Sunrise Computer 

Systems (07) 3368 3338 

♦ Technology One (07) 3870 2044 

♦ Unisys (07) 3361 1888 

SA - ♦ Applied Micro Systems 

(Australia) (08) 304 1700 ♦ Aspect 

Computing (08) 379 0466 

♦ Computer Management Centre 

(08) 223 0600 ♦ CPM&S (08) 362 

4949 ♦ Ferntree Computer 

Corporation (08) 373 0454 ♦ Ipex 

Information Technology Group (08) 

379 6911 ♦ Lodiri Computer 

Supplies (08) 332 5077 ♦ Matcom 

Systems (08) 269 7700 ♦ Protech 

Australia (08) 231 4066 

TAS - ♦ Prologic (002) 346 499 

♦ Sleebs Computer Industries (002) 

346 477 ♦ Tasram (002) 311189 

VIC - ♦ Argus Computer Systems 

(03) 9329 1844 ♦ Aspect Comput¬ 

ing (03) 9818 0604 ♦ AT&T Global 

Information Solutions (Australia) 

(03) 9321 3111 ♦ Attachmate 

Australia (03) 9694 6711 ♦ Business 

Computers of Australia (03) 9282 

0555 ♦ Computelec (03) 9786 7177 

♦ Datum Management Systems (03) 

9820 1988 ♦ Digital Equipment 

Corporation (Australia) (03) 9275 

3333 ♦ Ferntree Computer 

Corporation (03) 9622 8000 

♦ InfoMat Australia (03) 9888 6399 

♦ IPEX Information Technology 

Group (03) 9242 5000 ♦ LBMS (03) 

9642 1100 ♦ MicroHelp (03) 9388 

0111 ♦ Oakton Computing (03) 

9853 8855 ♦ Praxa Limited (03) 

9690 3811 ♦ Protech Australia (03) 

9690 6600 ♦ Taskforce Computer 

Services (03) 9888 9233 ♦ Unisys 

Australia (03) 9522 3081 ♦ WANG 

Australia (03) 9246 4400 

WA - ♦ Alpha West (09) 481 3293 

♦ Applied Micro Systems (Australia) 

(09) 265 9700 ♦ Australian Technol¬ 

ogy Resources (09) 483 8111 ♦ Co- 

Cam Computer Systems (09) 426 

1500 ♦ Ferntree Computer Corp¬ 

oration (09) 322 2730 ♦ Helicon 

Corporation (09) 481 1717 

♦ Integrated Systems Australia (09) 

470 4411 ♦ Q Technology (09) 367 

4022 ♦ Trilogy Resources (09) 324 

1462 

USER GROUPS 

ACT - ♦ LAN Manager User 

Group - Canberra (06) 267 6159 

♦ PC Users Group - Canberra (06) 

239 6511 

NSW - ♦ Apple and Macintosh 

Users Groups - Sydney (02) 

476 5792 ♦ Australian Windows 

Networking User Group - Sydney 

(02) 390 6299 ♦ C Languages Users 

& Enthusiasts Society (CLUES) - 

Sydney (018) 614 227 ♦ Central 

Coast PC User Group - (043) 322 

800 ♦ Club Mac Inc - Sydney (02) 

552 4126 or (043) 293 192 ♦ Fox 

User Group - Sydney (02) 746 9500 

♦ Programming S.I.G. (SPCUG) - 

Sydney (02) 599 1919 ♦ Microsoft 

Access User Group (Advanced) 

Sydney 041 19851995, Microsoft 

Access User Group - Parramatta 

(02) 891 1022 - Nth Sydney (02) 

9957 5888 - Microsoft SQL Server 

User Group (02) 888 9900 - Sydney 

BackOffice User Group, email: 

“ptybsd@microsoft.com” - Sydney 

Windows User Group (Excel and 

Word) (02) 415 2420 - Sydney PC 

Users Group - Main Meeting and 

Windows SIG (02) 972 2133 - 

Sydney PC User Group - Visual 

Basic SIG (02) 873 3700 - Visual 

Basic Users Group (02) 877 7225 

Vic - ♦ Access (Database) S.I.G. 

Melbourne - Melbourne (03) 9 

883 4382 ♦ FoxPro: The Melbourne 

Developer’s network - Melbourne 

(03) 9623 7668 ♦ Melbourne 

Access Users Group (03) 9727 

3877 ♦ Melbourne PC User 

Groups (03) 9699 6222 ♦ Microsoft 

Office Users Group 131 983 

♦ Retired and Interested Persons 

Melbourne (03) 9803 6229 

♦ Victorian Mac Users Group - 

Melbourne (03) 9654 7322 ♦ Visual 

Basic Users Group (03) 9878 3451 

Qld - ♦ Apple-Q Inc - Brisbane 

(07) 878 2834 (after 7pm) 

♦ Brisbane Access Users Group 

(07) 300 9999 ♦ Brisbug PC Users 

Group Inc (07) 201 5005 ♦ Logan 

City PC User Group - Qld (07) 208 

2332 ♦ Pine Rivers IBM Compatible 

Computer Club (07) 881 1553 

♦ Sunshine Coast Computer Users 

Group (074) 91 4680 ♦ Visual Basic 

Users Group (07) 835 5610 

♦ Windows Pacific (formerly 

Brisbane Windows User Group) 

(07)899 1956 

WA - ♦ Computer Club of WA 

[Inc] (09) 332 6374 ♦ Perth FoxPro 

User Group (09) 306 4847 ♦ Perth 

PC User Group (09) 328 3328 

♦ Perth Windows User Group 

(09) 386 6677 

SA - ♦ Adelaide Access for Users 

Group (08) 287 1470 ♦ Adelaide 

PC Users Group (08) 331 0766 

♦ Adelaide Micro Users Group 

Incorporated (08) 384 3027 

♦ South Australian PC Users 

Group (08) 341 9151 ♦ Visual Basic 

Users Group (08) 223 7932 

TAS - ♦ The Hobart Computer 

Users Group (002) 251 280 

If any details listed here are 
incorrect, please write to: 

Communique Magazine 
94-96 Pacific Highway, 
St Leonards, NSW 2065 
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COMMUNIQUE 

Nurs 
Age-old nursery rhymes were a part of all our child¬ 

hoods. We are all familiar with the fanciful fables that 

combined homely advice with elements that were 

exotic, absurd and often even grotesque. They and 

their accompanying pictures remain with us through¬ 

out our adult lives - part and parcel of the cultural 

map, popping up in all kinds of places. 

There are reveries like Twinkle Twinkle, lullabies, 

nonsense lyrics like Oranges and Lemons, tall tales 

and not a few frightening little condensed sagas, like 

Three Blind Mice. 

As these universally owned gems apply to all eras 

and ages, and often started out in fluid form, they can 

easily survive, even eqjoy, a little respectful updating - 

and still retain all the glory of their traditional shape. 

Let’s see.... 

Little Mod Miss Muffet 

Little Miss Muffet sat on a tuffet. 

Eating her curds and whey. 

The spider who spied her 

Denied that he tried ter 

Get into her laser display. 

censors note: alternative verbs - take part in/ 

cash in on her/woo her with a 

The Owl and the Pussycat get lost 

The owl and the pussycat went to sea 

In a beautiful pea-green boat. 

They took a computer 

But forgot to reboot her 

And ended up somewhere remote. 

Here we invite you to introduce some of these 

loved items from the universal treasury of nursery 

rhymes for a short (or perhaps even long) stay in the 

world of high technology and computers. 

The most imaginative contribution will earn its 

rhymer a copy of Fury3, with a Sidewinder for the run¬ 

ner-up. Send your entries to the Communique Nursery 

Nook, P.O. Box 222, St Leonards, NSW 2065 or email 

them to “cmq_ed@msn.com”. Entries close Monday, 

May 27,1996. 

Communique Crossword Competition No. 12 

Here we present the May Communique Crossword, which is, as usual, full of clues 
that contain either a synonym and a word play or two synonyms, while some are 
pure teasers. We’ll draw a winner on Monday, May 27, 1996, so be sure to have your 
entries to us by then. One entry per person, though photocopies are acceptable. 
The lucky winner will receive a copy of Microsoft’s Ancient Lands. 
Send your entry to "May Communique Crossword Competition”, 
P.O. Box 222, St Leonards, NSW 2065. 

Across 
I. Director of 3D animations organises 

a thousand over mike. [5,5] 
5. Put up some hints for a way of 

roasting meat [4] 
9. Leaps over any loose woman for a 

downloadable Internet kit [4-5] 
10. Eager to hide just how old she is. [3] 
11. Some never start to be clownish. [3] 
12. Former server has big reflections - 

and right in front of the altar. [9] 
14. Stocking only an indefinite number 

haphazardly. [5] 
15. Every ache unsettles. [4] 
16. Ms Blyton’s up to take tea. [4] 
19. The God of Love’s back to hurt. [4] 
20. Train ten to create internal business 

use of the highway. [8] 
22. Ends alien article. [2] 
23. Music that doesn’t start to 

capture.[3] 
25. “Show us the consumer^’ I answered 

the Mesopotamian wheel 
inventors. [9] 

27. Girl has style with no front. [4] 
28. Don’t introduce blood fluids to the 

period. [3] 

29. Sect gathers around a village pump 
to get an Internet server. [8] 

30. “Don’t sit, retinue!” fulminated the 
Web site publisher. [8,6] 

Down 
1. Reverent charms compose this 

secure online transaction 
provider. [8,6] 

2. Even bedlam keeps a tree. [3] 
3. Diced sausage will appease. [7] 
4. Information Technology scale re¬ 

drawn as recovering its shape. [7] 
6. Ten pearly versions of a product 

that’s great with a game of 
Golf. [6,3] 

7. Head/heart do a dance with a new 
book of Bill’s. [3,4,5] 

8. Tarts getting together to get 
going. [5] 

9. Go for it! [7] 
13. Prohibit a public proclamation. [3] 
17. In sum, by mistake, subtract! [5] 
18. Employ PC name to set up tents. [6] 
21. Get her a get-up of what’s hot [3,4] 
22. Guarantee mixtures are sus. [6] 
24. Said to smooth out flat country. [5] 
26. Found a buyer for about one 

body. [5] 



Surf Commonwealth Bank’s 
# _ - # www.commbank.com.au 

Internet site and the next site and discover a worm 
of banking covering 

VOU visit COUld be Fiji. everything from home 
v w loans to retirement. 

Then, by simply completing 

the entry form, you can also 

go in the draw for 

your choice of two great 

first prizes - either a 

Travelstrength holiday in 

Fiji or a Siemens Nixdorf 

Personal Computer, both 

valued at over $4,000. 

Other prizes for runners-up 

include annual subscriptions 

to Windows Sources, PC 

World, Computer Week and 

Family PC. 

Commonwealth 
Bank 

If you can’t visit, you can still enter — 
Send your entry to: Commonwealth Bank, P.O. Box 431, Virginia QLD 4014 

COM 

.Post, code* 

Phone: (Home). 

Do you use the World Wide Web? 

Email Address:. 

No | | Yes | | at Home, Work, Uni, School, Other (C >— 
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TRAINING 

Call now %for training in 

Communique members: 

(02) 262 39’00 Sydney 

(02) 9957 5888 North Sydney 

(02) 891 1022 Parramatta 

(03.) 9245 0444 Melbourne 

(07) 3229 3827 Brisbane 

Adelaide' 

Perth 
Canberra 

Wollongong 

Newcastle 


